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About this Guide
This guide describes the Tivoli Enterprise™ Data Warehouse enablement 
pack, version 1.1 (the warehouse pack). The warehouse pack is used with 
Peregrine Systems® ServiceCenter® version 5.1. 

You use the warehouse pack to store ServiceCenter data in the Tivoli® Data 
Warehouse. 

Topics in this preface include:

What is in this guide on page 8

Who should read this guide on page 8

Knowledge requirements on page 9

Related documentation on page 9
About this Guide  7
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What is in this guide

This guide provides information about:

Installing and configuring the warehouse pack

Data flows in the warehouse pack

Data structures that the warehouse pack uses

This guide includes the following chapters:

Chapter 1, Overview — provides an overview of Tivoli Enterprise Data 
Warehouse and the warehouse pack, including mapping information.

Chapter 2, Installation and Setup — provides information about installing 
and configuring the warehouse pack. Specifies prerequisite software 
installations, and includes information about database sizing.

Chapter 3, Transforming ServiceCenter Data — includes information 
about transferring data on your production system. Outlines the steps you 
take after loading new data into the central data warehouse, and provides 
instructions for maintaining the data after you load it.

Chapter 4, Central Data Warehouse Schema Implementation — provides 
information about which data should go into the incident and change 
database tables, and which data should go into ServiceCenter fields.

A note about examples
The examples included in this guide are for illustration only, and may differ 
from those at your site. 

Who should read this guide

This guide is for people who:

Plan for and install the warehouse pack

Use and maintain the warehouse pack and its reports

Create new reports

Create additional warehouse packs that use data from this warehouse pack
8  About this Guide 



Integration for Tivoli Enterprise Data Warehouse
Knowledge requirements

Administrators and installers should have the following knowledge or 
experience:

Basic system administration and file management skills

Basic relational database management skills

IBM DB2 Universal Database management skills

ServiceCenter administration experience

Connect-It administration experience

Tivoli Enterprise Data Warehouse administration experience

Report designers and warehouse pack creators should have the following 
knowledge or experience:

An understanding of the source data and application

Data warehouse information and design

Knowledge of extract, transform, and load (ETL) processes

Knowledge of online analytical processing (OLAP)

Related documentation

See the following sections for information about documentation that helps 
you understand, install, and manage the warehouse pack:

Peregrine documentation on page 9

Tivoli Enterprise Data Warehouse documentation on page 11

IBM DB2, DB2 Data Warehouse Center, and DB2 Warehouse Manager 
Documentation on page 14

Peregrine documentation
The following documents are available in the Peregrine library:

ServiceCenter Client/Server Installation Guide for OS/390 MVS

Provides instructions for installing the ServiceCenter OS/390 client and 
server. Includes instructions for configuring the client/server, including 
optional mail and interface functions.
Knowledge requirements  9
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ServiceCenter Client/Server Installation Guide for UNIX

Provides instructions for installing the ServiceCenter 5.1 client and server 
on a Unix platform. Includes instructions for configuring the 
client/server, including optional mail and interface functions.

ServiceCenter Client/Server Installation Guide for Windows

Provides instructions for installing the ServiceCenter 5.1 client and server 
on a Windows platform. Includes instructions for configuring the 
client/server, including optional mail and interface functions.

ServiceCenter Database Management and Administration Guide

Provides information about implementing ServiceCenter databases: 
hosting ServiceCenter data; converting ServiceCenter data from its 
internal format to a storage location on a commercial RDBMS; and 
maintaining the ServiceCenter file system. Provides information about 
retrieving, editing, and maintaining database records. 

ServiceCenter System Administrator's Guide

Provide instructions for configuring and managing the ServiceCenter 
system using basic ServiceCenter administrative tools and support files.

ServiceCenter System Tailoring

Describes customizing the ServiceCenter system, which requires 
knowledge of programming.

ServiceCenter Technical Reference

Provides information about installing and configuring ServiceCenter. 
Includes the command line and initialization file parameters that are 
recognized by the system

Connect-It Users Guide

Provides information about Connect-It scenarios and underlying 
concepts.

A complete listing of the current Peregrine Systems documentation is 
available on the documentation page of the Peregrine CenterPoint Web site:

http://support.peregrine.com/

Note: A user name and password are required for access to this site.

You can download PDF files and view them using the Adobe Acrobat Reader, 
which is available on the Customer Support Web site and through Adobe at:

http://www.adobe.com. 
10  About this Guide 
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Additionally, you can order printed copies of the documentation through 
your Peregrine Systems sales representative.

Education services
Peregrine Systems offers classroom training for all Peregrine products, on 
site anywhere in the world and via the Internet. 

Information about Peregrine Systems training services is available at: 

http://www.peregrine.com/education

Contacting Peregrine Systems
You can contact Peregrine Systems at:

http://support.peregrine.com/

Tivoli Enterprise Data Warehouse documentation
The following documents are available in the Tivoli Enterprise Data 
Warehouse library, both on the documentation CD and online at:

http://publib.boulder.ibm.com/tividd/td/tdprodlist.html

Also, see the section IBM DB2, DB2 Data Warehouse Center, and DB2 
Warehouse Manager Documentation on page 14.

Tivoli Enterprise Data Warehouse Release Notes, GI11-0857

Provides late-breaking information about Tivoli Enterprise Data 
Warehouse, and lists hardware requirements and software prerequisites.

Installing and Configuring Tivoli Enterprise Data Warehouse, GC32-0744

Describes how Tivoli Enterprise Data Warehouse fits into your enterprise, 
explains how to plan for its deployment, and gives installation and 
configuration instructions. It contains maintenance procedures and 
troubleshooting information.

Address: Peregrine Systems, Inc. 
Attn.: Education Services 
3611 Valley Centre Drive 
San Diego, CA 92130

Telephone: +1 (858) 794-5009

Fax: +1 (858) 480-3928
Related documentation  11
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ServiceCenter
Note: Be sure to get the most recent copy for up-to-date information.

Enabling an Application for Tivoli Enterprise Data Warehouse, GC32-0745

Provides information about connecting an application to the warehouse 
pack. This book is for:

Application programmers who use the warehouse pack to store and 
report on their application data

Data warehousing experts who import warehouse pack data into 
Business Intelligence applications

Customers who store their local data in the warehouse pack.

Related publications
The following publications provide information about the warehouse pack:

Tivoli Software Glossary 

Includes definitions for many of the technical terms related to Tivoli 
software. The Tivoli Software Glossary is available, in English only, at the 
following Web site:

http://publib.boulder.ibm.com/tividd/glossary/termsmst04.htm 

IBM Redbooks 

IBM Redbooks are developed and published by the IBM International 
Technical Support Organization (ITSO). They explore integration, 
implementation, and operation in realistic customer scenarios. 

The following Redbooks contain information about Tivoli Data Warehouse:

Introduction to Tivoli Enterprise Data Warehouse, SG24-6607 

Provides a broad understanding of Tivoli Data Warehouse. Some of the 
topics that are covered are: concepts, architecture, writing your own ETLs, 
and best practices in creating data marts. 

Planning a Tivoli Enterprise Data Warehouse Project, SG24-6608 

Describes the steps you take to plan a warehouse pack deployment. Shows 
how to apply planning steps in a real-life, warehouse pack implementation 
using IBM Tivoli Monitoring. Contains frequently used Tivoli and DB2 
commands, and lists troubleshooting tips for Tivoli Data Warehouse. 
12  About this Guide 
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Accessing publications online
The documentation and product CDs contain the product library. The 
publications are available in PDF format, HTML format, or both.

IBM posts publications for all Tivoli products on the Tivoli Software 
Information Center Web site:

http://publib.boulder.ibm.com/tividd/td/tdprodlist.html

Click the Tivoli Enterprise Data Warehouse link to access the warehouse 
pack product library.

Note: To print PDF documents on paper that is not letter-sized, select the Fit 
to page check box in the Adobe Acrobat Print dialog. This option is 
available when you click File Print. Fit to page ensures that the full 
dimensions of a letter-sized page print on the paper that you are using.

Ordering publications
You can order many Tivoli publications online at:

http://www.elink.ibmlink.ibm.com/public/applications/publications/cgi
bin/pbi.cgi

You can also order by telephone by calling one of these numbers:

In the United States: 800-879-2755

In Canada: 800-426-4968

In other countries, for a list of telephone numbers, see the following Web 
site: 

http://www.ibm.com/software/tivoli/order-lit/

Accessibility
Accessibility features help users who have a physical disability, such as 
restricted mobility or limited vision, to use software products successfully. 
For the warehouse pack, you use the interfaces of IBM DB2 and the reporting 
tool. See the documentation sets for those products for information about 
accessibility.

Contacting software support
If you have a problem with a Tivoli product, refer to the following IBM 
Software Support Web site:
Related documentation  13
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If you want to contact customer support, see the IBM Software Support 
Guide at the following Web site:

http://techsupport.services.ibm.com/guides/handbook.html

The guide provides information about how to contact IBM Software 
Support, depending on the severity of your problem, and includes:

Registration and eligibility information

Telephone numbers and e-mail addresses, depending on the country in 
which you are located

Information you have ready before contacting IBM Software Support

IBM DB2, DB2 Data Warehouse Center, and DB2 Warehouse 
Manager Documentation

The DB2 library contains important information about the database and 
data warehousing technology provided by IBM DB2, DB2 Data Warehouse 
Center, and DB2 Warehouse Manager. Refer to the DB2 library for help in 
installing, configuring, administering, and troubleshooting DB2. The DB2 
library is available online at:

http://www-3.ibm.com/software/data/db2/library/

After you install DB2, its library is also available on your system.

The following DB2 documents are particularly relevant for people working 
with Tivoli Enterprise Data Warehouse:

IBM DB2 Universal Database for Windows Quick Beginnings, GC09-2971

Guides you through the planning, installation, migration (if necessary), 
and setup of a partitioned database system using the IBM DB2 product on 
Microsoft Windows.

IBM DB2 Universal Database for UNIX Quick Beginnings, GC09-2970

Guides you through the planning, installation, migration (if necessary), 
and setup of a partitioned database system using the IBM DB2 product on 
UNIX.

IBM DB2 Universal Database Administration Guide: Implementation, 
SC09-2944
14  About this Guide 
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Integration for Tivoli Enterprise Data Warehouse
Covers the details of implementing your database design. Topics include 
creating and altering a database, database security, database recovery, and 
administration using the DB2 Control Center, which is a DB2 graphical 
user interface.

IBM DB2 Universal Database Data Warehouse Center Administration 
Guide, SC26-9993

Provides information about using the DB2 Data Warehouse Center to 
build and maintain a data warehouse.

IBM DB2 Warehouse Manager Installation Guide, GC26-9998

Provides information about installing the following Warehouse Manager 
components: Information Catalog Manager, warehouse agents, and 
warehouse transformers.

IBM DB2 Universal Database and DB2 Connect Installation and 
Configuration Supplement, GC09-2957

Addresses advanced installation issues, and guides you through the 
planning, installation, migration (if necessary), and set up of a 
platform-specific DB2 client. Contains information about binding, setting 
up communications on the server, DB2 GUI tools, DRDA® AS, 
distributed installation, configuration of distributed requests, and 
accessing heterogeneous data sources.

IBM DB2 Universal Database Message Reference Volume 1, GC09-2978 and 
IBM DB2 Universal Database Message Reference Volume 2, GC09-2979

Lists the messages and codes issued by DB2, the Information Catalog 
Manager, and the DB2 Data Warehouse Center; and describes the actions 
you should take.
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CHAPTER
1 O
verview
Tivoli Enterprise Data Warehouse consists of a centralized data store where 
historical data from many management applications can be stored, 
aggregated, and correlated.

This chapter provides an overview of Tivoli Enterprise Data Warehouse, the 
warehouse pack, and mapping information. 

Topics in this chapter include:

Overview of Tivoli Enterprise Data Warehouse on page 18

Overview of the warehouse pack on page 20

Mapping ServiceCenter data on page 23
Overview  17
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Overview of Tivoli Enterprise Data Warehouse

Tivoli Enterprise Data Warehouse provides the infrastructure for the 
following:

Using extract, transform, and load (ETL) processes through the DB2 Data 
Warehouse Center tool

Generating a schema of the central data warehouse

Reporting historical data

Figure 1-1:  Tivoli Enterprise Data Warehouse basic architecture
18 Chapter 1—Overview 
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Terminology
The table below defines some common Tivoli Enterprise Data Warehouse 
terms. This guide also uses some terminology defined in the ITIL standard. 
See Best Practice for Service Support for definitions of ITIL standard terms.

Table 1:  Tivoli Enterprise Data Warehouse terminology

Term Definition

Attributes Describe components and are generally used to help filter the components.

ETL A DB2 Data Warehouse Center tool used to extract, transform, and load 
(ETL) data into DB2 from other databases. 

Warehouse pack A separately installable part of a software product that provides TEDW 
functionary by providing Extract, Transform, and Load ETL programs to 
populate the central data warehouse. 

PCHILD A naming relationship between components. 

A PCHILD (parent/child) relationship between the SERVICE_DESK and 
the INCIDENT components means that, within the context of an 
installation of SERVICE_DESK, all the INCIDENT components have a 
unique name. For example, incident number 287 on service desk server 1 
would be different from incident number 287 on service desk server 2.

Central data warehouse Uses a single generic schema for all applications. When you add new 
components or applications to the warehouse, the Tivoli Enterprise Data 
Warehouse adds more data to the database, but not new tables or columns 
to the schema.

Data mart A subset of a data warehouse that contains data that are tailored and 
optimized for the specific reporting needs of a department or team.

Central data warehouse ETL Reads data from the operational data stores of the application that collects 
it; verifies the data; makes the data conform to the schema; and places the 
data into the central data warehouse.

Data mart ETL Extracts a subset of data from the central data warehouse; transforms it; 
and loads it into one or more star schemas, which can be included in data 
marts to answer specific business questions.
Overview of Tivoli Enterprise Data Warehouse  19
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Overview of the warehouse pack

This warehouse pack is used with Tivoli Enterprise Data Warehouse version 
1.1 and with ServiceCenter version 5.1. You can use it to transfer data from 
ServiceCenter to DB2. The installation includes several Connect-It scenarios 
and ETL processes. 

Connect-It scenarios
The Connect-It scenarios included in this warehouse pack convert 
ServiceCenter data into the XML format required by the ETL processes.

Though the technology used by a service desk can change over time, the ETLs 
will continue to function correctly as long as the mapping to the XML file 
remains correct. (All elements marked as mandatory in the DTD are 
included in the data exported to the XML file.) 

The ETL converts only the data that is in the XML file. If you do not want 
certain data flowing into the Tivoli Enterprise Data Warehouse, do not 
include it in the data exported to the XML file. 

Scenarios installed by the warehouse pack include:

SC5Xprobsummary.to.Tivoli Enterprise Data Warehouse.scn 
This scenario processes ServiceCenter Incident records. 

SC5Xincidents.to.Tivoli Enterprise Data Warehouse.scn  
This scenario processes ServiceCenter Call records.

SC5Xcm3r.to.Tivoli Enterprise Data Warehouse.scn 
This scenario processes ServiceCenter Change records.

ETL processes
The following ETL processes are included in the warehouse pack:

PE2_c05_Load_Service_Desk_Data_Process

Run this process to load new data into the central data warehouse. 

The process loads the XML staging tables, using the XML data files 
exported from the Peregrine databases; transforms them into a format 
that is compatible with the central data warehouse; and loads the data.

For more information see PE2_c05_Load_Service_Desk_Data_Process on 
page 21.
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PE2_c10_Purge_Comps_And_Attrs

Run this process after you load new data into the central data warehouse.

The process drops the XML staging tables that were used by 
PE2_c05_Load_Service_Desk_Data_Process.

For more information see PE2_c10_Purge_Comps_And_Attrs on page 21.

Note: For testing purposes, run PE2_c10_Purge_Comps_And_Attrs 
using the sample files. After testing is complete, run 
PE2_c10_Purge_Comps_And_Attrs on production data files.

Tip: Schedule ETLs to run periodically, ideally during non-peak hours.

PE2_c05_Load_Service_Desk_Data_Process
Steps included in the process:

1 PE2_c05_s010_Load_Into_Staging: loads the ServiceCenter 
application-component XML staging tables using XML data files exported 
from the Peregrine databases.

2 PE2_c05_s020_Comp: takes the ServiceCenter application-component XML 
staging tables as input; transforms the component data; and loads the data 
into the central data warehouse.

3 PE2_c05_s030_Msmt: takes the ServiceCenter application-component XML 
staging tables as input; transforms the measurement data; and loads the data 
into the central data warehouse.

PE2_c10_Purge_Comps_And_Attrs
Step included in the process:

PE2_c10_s010_Purge_Comps: drops and re-creates all ServiceCenter 
application-component XML staging tables that are used in the ETL 
processing.

Component Relationships
Figure 1-2 on page 22 shows the major service desk components and the 
warehouse relationships between those components. The arrows are usually 
optional. For example, not all Change requests cause Incidents, but Incidents 
often drive Change requests. Therefore, the relationship between incidents 
and Change request is bi-directional. If there is a relationship between the 
change and the incident, it is the Causes relationship. In addition, the arrows 
also allow one-to-many mapping. For example, numerous incidents may 
have a relationship with a single change request.
Overview of the warehouse pack  21
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Note: Incident and Change Request components save attribute data about 
configuration attributes, but the ETL does not create a configuration 
asset object, nor relationships between that object and the 
corresponding Incident or Change Request.

Figure 1-2:  Component Types and Relationships

Component Structure 
The component structure uses PCHILD relationships, which are discussed in 
the section Terminology on page 19.

The component structure uses these models:

SERVICE_DESK -> INCIDENT -> SD_USER

SERVICE_DESK -> CHANGE_REQUEST -> SD_USER

SERVICE_DESK -> CHANGE_REQUEST -> CR_TASK

Components used in the structure include:

SERVICE_DESK — This high-level component represents the installation 
of ServiceCenter itself. 

If an installation contains multiple copies of ServiceCenter, the warehouse 
pack creates multiple components for each machine running a 
ServiceCenter server. Each ServiceCenter server requires its own 
scenarios, which point to its host name and port number. This structure 
ensures that Incident and Change numbers do not conflict where multiple 
ServiceCenter installations exist. 

Service_Desk

PCHILD

CR_TASK SD_USER

Change_Request

PCHILD

PCHILD

SD_USER

Incident

PCHILD

PCHILD

Causes
22 Chapter 1—Overview 



Integration for Tivoli Enterprise Data Warehouse
When an aggregation such as the number of open incidents are reported 
against the SERVICE_DESK component, the aggregation represents all 
incidents opened during a time interval, and only for that instance of the 
SERVICE_DESK server session. 

CHANGE_REQUEST, and INCIDENT — The modeling is basically the 
same for the both components. The component name is a unique change 
or incident number. Almost everything else (such as severity, system, open 
time, contact, status, abstract, and description) is an attribute. Attributes 
describe components and are generally used to help filter the components.

SD_USER — There can be multiple users, such as the requester, the 
contact, or the approver of a change. This component contains 
information about each user, such as e-mail address and phone number, 
that is not specific to the incident or change.

Mapping ServiceCenter data

The following sections describe how ServiceCenter data are mapped to the 
data warehouse.

Data flow
The following diagram depicts the data flow from the ServiceCenter database 
to the central data warehouse.

Figure 1-3:  ServiceCenter data Mapping

ServiceCenter

ServiceCenter Data Mapping

Central Data
Warehouse

       XML Files
         - Calls
         - Incidents
         - Changes
         - ....

XML
Warehouse

Representation

Export via Connect-It XSLT Conversion Data Loading
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Data mapping tables
The following tables show the complete mapping of the Service Center data 
to the central data warehouse (CDW).

Important: The XML and central data warehouse mappings contain extra 
fields that are not included in ServiceCenter as shipped. These 
additional fields are for any extra fields in your ServiceCenter 
installation.

In the mapping tables below, three columns show how the data maps to the 
central data warehouse tables. 

The CDW column name represents the column name in the CDW tables. 

The A C M identifies the field as an Attribute, a Component, or a 
Measurement in the CDW. 

The CDW type specifies the name of the specific Attribute Type, 
Component Type, or Measurement Type used in the CDW.

If the CDW type is an Attribute Type, then it is important to know what 
component in the CDW is associated with that attribute. The convention 
used in this table is to use the prefix IN- if the attribute is associated with 
the INCIDENT component, CR- if the attribute is associated with the 
CHANGE_REQUEST component, TK- if the attribute is associated with 
the CR_TASK component, and SD_USER- if the attribute is associated 
with the SD_USER component. A much more detailed example of how 
the data is saved in the warehouse is shown in the Component 
Configuration tables section.

Note: You use a hostname and port number to identify each ServiceCenter 
instance.
24 Chapter 1—Overview 
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CDW  
column name

C Comp_Nm

C *

CompAttr_Val

CompAttr_Val

in CompAttr_Val

CompAttr_Val

in CompAttr_Val

in CompAttr_Val

in CompAttr_Val

Comp_Nm

C CompAttr_Val

in CompAttr_Val

in

in

in CompAttr_Val

in CompAttr_Val

in CompAttr_Val

in CompAttr_Val

in CompAttr_Val
Incident data

ource  
pplication Table

Field Names Corresponding 
Names in dtd file

CDW Type CHAR (17) A C M

I Mapping "Unknown "hostname SERVICE_ DESK C

I Mapping "12670 "port * *

Incident INCIDENT A

assignee IN-ASSIGNEE_NAME A

cidents assignment,1 assignmentGroup IN-SD_ ASSIGN_GROUP A

fixTime IN-FIX_TIME A

cidents close.time closeTime IN-CLOSE_TIMESTAMP A

cidents cause.code abstract IN-ABSTRACT A

cidents description description IN-DESCRIPTION A

incident.id Id - INCIDENT C

I Mapping "Service "type IN-TYPE A

cidents open.time openTime IN-OPEN_TIMESTAMP A

cidents resolution resolution -> 
description

Not Modeled

cidents resolution.code resolution -> code Not Modeled

cidents category category IN-SD_SYSTEM A

cidents cause.code causeCode IN-SD_CAUSE_CODE A

cidents owner.name owner IN-OWNER A

cidents priority.code priority IN-PRIORITY A

cidents problem.type problemType IN-SD_PROBLEM_TYPE A
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CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

ulti-valued
CompAttr_Val

CompAttr_Val

CompAttr_Val

C M CDW  
column name
incidents product.type productType IN-SD_PRODUCT_TYPE A

closedByID IN-CLOSED_BY A

impact IN-IMPACT A

firstCall Resolution IN-FIRST_CALL_RES A

dueDate IN-DUE_DATE

item IN-SD_ITEM A

module IN-SD_MODULE A

severity IN-SEVERITY A

site IN-SITE A

incidents site.category siteCategory IN-SD_SITE_CATEGORY A

incidents open status IN-SD_STATUS_CODE A

incidents subcategory subcategory IN-SD_COMPONENT A

incidents affected.item affectedAsset -> id IN-SD_ASSETS_AFFECTD A 
m

affectedAsset -> name Not Modeled

affectedAsset -> 
IPAddress

Not Modeled

affectedAsset -> 
fullyQualifiedHostname

Not Modeled

affectedAsset -> 
relationship

Not Modeled

incidents company contact -> company IN-COMPANY A

incidents company contact -> company SD_USER-COMPANY A

Source  
Application Table

Field Names Corresponding 
Names in dtd file

CDW Type CHAR (17) A 
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in CompAttr_Val

in CompAttr_Val

in CompAttr_Val

in Comp_Nm

in CompAttr_Val

in CompAttr_Val

in CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

in CompAttr_Val

CompAttr_Val

CompAttr_Val

in

in CompAttr_Val

in

S
A

CDW  
column name
cidents dept contact -> department IN-DEPARTMENT A

cidents dept contact -> department SD_USER-DEPARTMENT A

cidents contact.email contact -> email SD_USER-E_MAIL_ADDRESS A

cidents contact.name contact -> id SD_USER C

cidents contact.name contact -> id IN-CONTACT A

cidents contact.first contact -> firstName SD_USER-FIRST_NAME A

cidents contact.last contact -> lastName SD_USER-LAST_NAME A

contact -> userID SD_USER-SD_USERID A

contact -> cellPhone SD_USER-CELL_ 
PHONE_NUMBER

A

contact -> division SD_USER-DIVISION A

contact -> division IN- DIVISION A

cidents phone contact -> officePhone SD_USER-PHONE_NUMBER A

site SD_USER-SITE A

siteCategory SD_USER-SD_ 
SITE_CATEGORY

A

cidents company reportedBy -> company Not Modeled

cidents alternate.contact reportedBy -> id IN-SD_REPORTD_BY_NM A

cidents alternate.phone reportedBy -> 
officePhone

Not Modeled

reportedBy -> division Not Modeled

reportedBy -> 
firstName

Not Modeled

ource  
pplication Table

Field Names Corresponding 
Names in dtd file

CDW Type CHAR (17) A C M
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ulti-valued

CompAttr_Val

MsmtTyp_Nm

Msmt_tot_val

C M CDW  
column name
reportedBy -> lastName Not Modeled

reportedBy -> userID Not Modeled

reportedBy -> 
employeeNumber

Not Modeled

reportedBy -> 
department

Not Modeled

reportedBy -> email Not Modeled

reportedBy -> cellPhone Not Modeled

incidents screlation -> source relatedChange -> id IN-SD_RELATED_CHNGS A 
m

relatedChange -> 
relationshipType

Not Modeled

relatedincidents -> 
relationshipType

Not Modeled

relatedAsset -> id Not Modeled

relatedAsset -> name Not Modeled

relatedAsset -> 
IPAddress

Not Modeled

relatedAsset -> 
fullyQualifiedHostname

Not Modeled

relatedAsset -> 
relationship

Not Modeled

incidents clocks.name state -> code INCIDENT M

incidents clocks.total state -> duration INCIDENT M

Source  
Application Table

Field Names Corresponding 
Names in dtd file

CDW Type CHAR (17) A 
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 the clocks file. 

in the clocks file. 
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in Msmt_Strt_Dt  
Msmt_Strt_Tm

in

CompAttr_Val

S
A

CDW  
column name
The following are supporting ServiceCenter tables:

screlation table - can be either:

A join from the incidents file based upon incident.id to the depend field in th
related changes, it queries against records with the source file name of cm3r; 
it queries against records with the source file name of problem.

A join from the probsummary file based upon number to the depend field i
For related changes, it queries against records with the source file name of cm
it queries against records with the source file name of incidents.

clocks table - can be either:

A join from the incidents file based upon incident.id to the key.char field in

A join from the probsummary file based upon number to the key.char field 

For information on ServiceCenter clocks, see ServiceCenter System Tailoring

state -> startTime <msmt calculation> M

state -> endTime <msmt calculation>

cidents clocks.events.start state -> details -> 
startTime 

INCIDENT M

cidents clocks.events.stop state -> details -> 
endTime

INCIDENT M

contact -> 
employeeNumber

SD_USER- 
EMPLOYEE_NUMBER

A

reportedBy -> company Not Modeled

updateActivity -> type Not Modeled

ource  
pplication Table

Field Names Corresponding 
Names in dtd file

CDW Type CHAR (17) A C M
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number field in the activity 

 C A CDW  
column name

Comp_Nm

*

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

Comp_Nm

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val
activity table - A join of the number field in the probsummary file to the 
file. 

Change Management data

Source  
Application Table

Field Names Corresponding 
Names in DTD file

CDW TypeCHAR (17) M

CI Mapping 
connector

hostname unknown SERVICE_DESK C

CI Mapping 
connector

port 12670 * *

cm3r brief.description abstract CR-ABSTRACT A

cm3r approval.status approvalStatus CR-CR_APP_STATUS A

cm3r close.time completeDate CR_COMPLETE_DATE A

cm3r description description CR-DESCRIPTION A

cm3r openTime CR-OPEN_TIMESTAMP A

cm3r number Id CHANGE_REQUEST C

cm3r request.date requestDate CR_REQUEST_DATE A

cm3r status Status CR_STATUS_CODE A

cm3r assigned.to assignee CR-ASSIGNEE_NAME A

cm3r backout.method backoutPlan CR-CR_BACKOUT_PLAN A

cm3r completion.code completionCode CR-CR_COMPLETION_CD A

cm3r priority priority CR-CR_PRIORITY A

cm3r risk.assessment riskLevel CR-SD_RISK_LEVEL A

cm3r subcategory subsystem CR-SD_COMPONENT A

cm3r item CR-SD_ITEM A
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c CompAttr_Val

c CompAttr_Val

c CompAttr_Val

c CompAttr_Val

c CompAttr_Val

c

c

c

S
A

CDW  
column name
m3r module CR-SD_MODULE A

m3r category system CR-SD_SYSTEM A

m3r down.start actualDate -> start CR-CR_ACT_START A

m3r down.end actualDate -> end CR-CR_ACT_END A

m3r outage.end actualOutage -> end CR-CR_ACT_OUTAGE_ED A

m3r outage.start actualOutage -> start CR-ACT_OUTAGE_ST A

m3r coord.dept coordinator ->  
department

Not Modeled

m3r coordinator coordinator -> id Not Modeled

m3r coord.phone coordinator ->  
officePhone

Not Modeled

coordinator ->  
firstName

Not Modeled

coordinator -> 
lastName

Not Modeled

coordinator -> userID Not Modeled

coordinator -> 
employeeNumber

Not Modeled

coordinator -> division Not Modeled

coordinator -> 
cellPhone

Not Modeled

coordinator -> email Not Modeled

coordinator -> 
company

Not Modeled

ource  
pplication Table

Field Names Corresponding 
Names in DTD file

CDW TypeCHAR (17) M C A
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CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

Comp_Nm

CompAttr_Val

CompAttr_Val

CompAttr_Val

 C A CDW  
column name
cm3r planned.start plannedDate -> start CR-CR_PLAN_START A

cm3r planned.end plannedDate -> end CR-CR_PLAN_END A

cm3r sched.outage.start plannedOutage -> start CR-CR_PLAN_OUTAGE_ST A

cm3r sched.outage.end plannedOutage -> end CR-CR_PLAN_OUTAGE_ED A

cm3r logical.name relatedAssets -> id CR-SD_ASSETS_AFFECTD A

N/A - calculated CR_START_DELAY A

N/A - calculated CR_END_DELAY A

relatedAsset -> name Not Modeled

relatedAsset -> 
IPAddress

Not Modeled

relatedAsset -> 
fullyQualifiedHostname

Not Modeled

relatedAsset -> 
relationship

Not Modeled

cm3r company requester -> company SD_USER-COMPANY A

cm3r company requester -> company CR-COMPANY A

cm3r request.dept requester -> department SD_USER-DEPARTMENT A

cm3r request.dept requester -> department CR-DEPARTMENT A

cm3r requested.by requester -> id SD_USER C

cm3r requested.by requester -> id CR-CONTACT A

cm3r contact.first.name requester -> firstName SD_USER-FIRST_NAME A

cm3r contact.last.name requester -> lastName SD_USER-LAST_NAME A

Source  
Application Table

Field Names Corresponding 
Names in DTD file

CDW TypeCHAR (17) M
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c CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

CompAttr_Val

lued
CompAttr_Val

lued
CompAttr_Val

lued
CompAttr_Val

s CompAttr_Val

c MsmtTyp_Nm

c Msmt_tot_val

S
A

CDW  
column name
m3r request.phone requester -> 
officePhone

SD_USER-PHONE_NUMBER A

requester -> userID SD_USER-SD_USERID A

requester -> 
employeeNumber

SD_USER- 
EMPLOYEE_NUMBER

A

requester -> division SD_USER-DIVISION A

requester -> email SD_USER-E_MAIL_ADDRESS A

requester -> cellPhone SD_USER- 
CELL_PHONE _NUMBER

A

requester -> division CR-DIVISION A

ApprovalLog -> 
action

authorization -> action CR_APP_ACTION A  
multi-va

ApprovalLog -> 
category

authorization -> type Not modeled

ApprovalLog -> date authorization -> 
timestamp

CR-APPROVAL_TIMESTAMP A 
multi-va

ApprovalLog -> 
operator

authorization -> 
approver

CR-APPROVER_NAME A 
multi-va

crelation screlation -> source relatedIncident -> id CR-SD_RELATED_INCS A

locks name state -> code CHANGE_REQUEST M

locks total state -> duration CHANGE_REQUEST M

state -> startTime <msmt calculation>

state -> endTime <msmt calculation>

ource  
pplication Table

Field Names Corresponding 
Names in DTD file

CDW TypeCHAR (17) M C A
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 C A CDW  
column name

M C A CDW  
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ge

A CompAttr_Val

A CompAttr_Val

A CompAttr_Val

A CompAttr_Val
Supporting ServiceCenter tables:

ApprovalLog table - A join of the numberin the cm3r file to the unique.ke
file, where approval records have a file.name value of cm3r. 

screlation table - A join of number in the cm3r file to the depend field i
related changes, it queries records with the source file name of cm3r; for
against records with the source file name of incidents.

clocks table - A join of number in the cm3r file to the key.char field in th

Change Management tasks
Tasks are defined in the DTD, and modeled in the CDW as components un
are not included in the exported data. 

clocks events -> start state -> details -> 
startTime 

CHANGE_REQUEST M

clocks events -> stop state -> details -> 
endTime

CHANGE-REQUEST M

Source  
Application Table

Field Names Corresponding 
Names in DTD file

CDW TypeCHAR (17) M

Source Application 
table

Field Names Corresponding 
Names in dtd file

CDW Type CHAR (17)

task -> id CR_TASK

task-related ChangeRequest -> id Relationship back to parent chan

task -> phase TK-CR_TASK_PHASE

task -> status TK-CR_TASK_STATUS

task -> startTime TK-CR_PLAN_START

task -> endTime TK-CR_PLAN_END
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 C A CDW  
column name
ServiceDeskTasks ->  
relationshipType

Not modeled

task -> description TK-CR_TASK_DESC A

ource Application 
able

Field Names Corresponding 
Names in dtd file

CDW Type CHAR (17) M
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CHAPTER
2 I
nstallation and Setup
This chapter provides information on how to install and configure the 
warehouse pack, including prerequisite software installations, and 
information on database sizing.

Topics in this chapter include:

Prerequisite software on page 38

Product notes and limitations on page 38

Database sizing considerations on page 38

Warehouse pack installation on page 40
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Prerequisite software

The warehouse pack requires that several external software packages be 
installed in order to run. Be sure that these software packages are set up and 
running properly before beginning the installation:

IBM DB2 Universal Database Enterprise Edition, Version 7.2, fix pack 6 
or greater

For information on installing IBM DB2 Universal Database, see the IBM 
DB2 documentation.

Tivoli Enterprise Data Warehouse, Version 1.1

For information on installing Tivoli Enterprise Data Warehouse, see 
Installing and Configuring Tivoli Enterprise Data Warehouse.

Tivoli Enterprise Data Warehouse, Version 1.1, fix pack 2 or greater 
(1.1-TDW-FP02) 

IBM DB2 Universal Database XML Extender, Version 7.1, fix pack 9 or 
greater

ServiceCenter version 5.1 or greater

For information on installing ServiceCenter, see the ServiceCenter 
Client/Server Installation Guide for your platform.

Connect-It version 3.2.1.3319 or greater

For information on installing Connect-It, see the Connect-It Installation 
Guide.

Product notes and limitations

This warehouse pack currently does not allow spaces in paths and filenames 
due to the lack of XSLT support for this. To get around this, set the 
environment values on your server to have no spaces in the filenames. 

Database sizing considerations

Ensure that you have sufficient space in the CDW database to store the 
historical data that you intend to collect with this warehouse pack. To 
estimate how much space is required for the warehouse pack, complete the 
Daily Central Data Warehouse estimate worksheet on page 39. 
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The following values are assumed in this sample worksheet. Adjust these 
numbers to match the normal daily behavior in your environment:

The average length for a row in the component table is 150 bytes. This 
varies depending on the actual lengths of some of the strings for the 
Incident abstracts. 

The Tivoli Enterprise Data Warehouse requires 176 bytes for 
measurements.

The component attribute table requires 90 bytes.

The following transaction volumes: 100 incidents per day, 50 Change 
Requests per day, and 5 tasks per change request. 

Daily Central Data Warehouse estimate worksheet

Object managed Count Space Formula  
In Bytes

Number of Incident measurements per service desk 2 35200

Number of Change Request measurements per 
service desk

10 88000

Number of Incidents per day 100 15000

Number of attributes per Incident 29 522000

Number of Incident Measurements 5 88000

Number of User Incident Measurements 2 35200

Number of Incident User Attributes 15 270000

Number of Incident User Components 100 15000

Average Number of attribute changes 2

Number of Change Request per day 50 7500

Number of attributes per Change Request 34 306000

Number of Change Request Measurements 18 158400

Number of User Change Request Measurements 9 79200

Number of Change Request User Attributes 15 135000

Number of Tasks per Change Request 5 37500

Number of Attributes per Task 5 45000

Number of Change Request User Components 50 7500
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Warehouse pack installation

These major steps are required to complete the warehouse pack installation:

Step 1 Installing the warehouse pack on page 41

Step 2 Installing the Connect-It scenario on page 42

Step 3 Configuring the warehouse pack on page 43

Step 4 Configuring the Connect-It scenario on page 49

Files used and produced by the warehouse pack
The following table lists different types of ServiceCenter data, and the files 
that are used to transform that type of data.

Daily Total (bytes) 776100

Monthly Total (bytes) 23283000

Yearly Total (bytes) 279396000

Object managed Count Space Formula  
In Bytes

ServiceCenter  
Application

ServiceCenter  
Table

Tivoli Enterprise  
Data Warehouse  
XML File

Connect-It Scenario DTD File

Service 
Management

incidents incidents.xml SC5Xincidents.to.Tivoli  
Enterprise Data  
Warehouse.scn

Incidents.dtd

Incident Management probsummary probsummary.xml SC5Xprobsummary.to. 
Tivoli Enterprise Data  
Warehouse.scn

Incidents.dtd

Change Management cm3r cm3rs.xml SC5Xcm3r.to.Tivoli  
Enterprise Data  
Warehouse.scn

Change.dtd
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Installing the warehouse pack 
This installation requires access to information on the Tivoli Enterprise Data 
Warehouse installation CD and the warehouse pack installation CD. Unless 
you have 2 CD-ROM drives, we recommend that you copy the warehouse 
pack CD to your hard drive or a network drive so that the installer can access 
both at the same time. 

Perform the installation on your Tivoli Enterprise Data Warehouse control 
server. 

To install the warehouse pack:

1 Ensure that your setup matches the software requirements described in 
Prerequisite software on page 38.

2 Set the environment values for your server. For more information, see 
Product notes and limitations on page 38. 

On Windows 2000 servers:

a Right-click My computer on your desktop, and select Properties from the 
menu.

b Select the Advanced tab and click Environment Values.

c Edit the following System Variables to remove all spaces from the file 
names.

Path 

TWH_TOPDIR 

For example, change any occurrence of Program Files to progra~1.

3 Start the Tivoli Enterprise Data Warehouse installation program and follow 
the instructions given by the installer. The installation program is located on 
the Tivoli Enterprise Data Warehouse product CD.

a When prompted to choose a setup type, select Application installation 
only.

b When prompted to enter the path to the installation media, enter the path 
to the warehouse pack ETL applications. They are located on the 
warehouse pack installation CD under: D:\ETLapps\tedw_apps_etl.

c Complete the installation, following the instructions given by the installer.

For more information, see Installing and Configuring Tivoli Enterprise Data 
Warehouse.
Warehouse pack installation  41



ServiceCenter
4 Manually stop and restart the following services for Tivoli Presentation 
Services:

Server for IBM Console

Web Services for the IBM Console

For more information, see Installing and Configuring Tivoli Enterprise Data 
Warehouse.

Installing the Connect-It scenario
Connect-It Scenarios process ServiceCenter records and convert them into 
the XML format required for Tivoli Enterprise Data Warehouse 
transformation.

To install the Connect-It scenarios:

1 Ensure that your setup matches the software requirements described in 
Prerequisite software on page 38.

2 Create a new directory (SCtoTEDW in this example) under the main 
ConnectIt\scenario\ directory. 

For example, if your current Connect-It installation resides in:  
C:\Program Files\Peregrine\ConnectIt\scenario\

Create  
C:\Program Files\Peregrine\ConnectIt\scenario\SCtoTEDW.

3 Copy the following scenarios and the DTD from the installation location to 
the new directory, and remove the Read-only property in each:

SC5Xcm3r.to.Tivoli Enterprise Data Warehouse.scn

SC5Xprobsummary.to.Tivoli Enterprise Data Warehouse.scn

SC5Xincidents.to.Tivoli Enterprise Data Warehouse.scn

incidents.dtd

change.dtd

These files are on the install CD in D:\Peregrine\ConnectIt\Scenarios\.
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4 Copy the date.usr file from the install location into the new directory, and 
remove its Read-only property. This file resides on the install CD in 
D:\Peregrine\ConnectIt\date.usr.

5 Copy the file scdb51TEDW.cfg from the install CD to  
C:\Program Files\Peregrine\ConnectIt\config\sc\scdb51TEDW.cfg, and 
remove its Read-only property. This file resides on the install CD in 
D:\Peregrine\ConnectIt\.

Configuring the warehouse pack
After you install the warehouse pack, use the DB2 Data Warehouse Center to 
configure its data sources and targets. Complete information is found in 
Installing and Configuring Tivoli Enterprise Data Warehouse.

To configure the warehouse pack:

1 Following the instructions in Installing and Configuring Tivoli Enterprise 
Data Warehouse, specify the Control database for the DB2 Data Warehouse 
Center to TWH_MD. 
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2 Open the IBM DB2 Control Center. (Go to Start > Programs > IBM db2 > 
Control Center.) 

3 From the Tools menu, select Data Warehouse Center.

4 Log on to the Data Warehouse Center.

5 Specify the User ID and Password for the Warehouse Source, 
PE2_TWH_CDW_Source.

a In the User ID field, type the User ID used to access the central data 
warehouse database (the instance name for the <configuration 
repository>.) The default value is db2admin.

b In the Password field, type the appropriate password.
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6 Specify the properties for the warehouse target, PE2_TWH_CDW_Target.

a In the User ID field, type the user ID used to access the central data 
warehouse database. The default value is db2admin.

b In the Password field, type the password.

Setting up the warehouse pack configuration files
The PE2_c05 Load_Service_Desk_Data_Process uses the sd_cfg.xml file to 
determine where the XML files to be processed are located, and where to put 
the data. The sd_cfg.xml file contains the paths to the XML files that move 
the data. Edit the sd_cfg.xml file to enter the correct path and filenames for 
the XML sources and targets. The states file contains the paths to the DTD 
file. Edit the State file to enter the correct path and filename for the DTD file.

To edit the configuration and states files:

1 Open the file 
<TWH_TOPDIR>\apps\pe2\v110\misc\transforms\sd_cfg.xml for editing.

2 For each source Incident file and each source Call file you intend to 
transform and insert into the Warehouse, add the following line to the 
sd_cfg.xml file anywhere between the <configuration> and 
</configuration> tags: 

<incident-file name="fully_qualified_source_filename" /> 

where "fully_qualified_source_filename" (including the double quotes) is 
the full path of the source file. 

Note: After your modifications are complete, the sd_cfg.xml file should 
contain two lines starting with the <incident-file name= parameter. 
One is for incident data and the other is for probsummary data.

For Windows add:

<incident-file name= 
"C:\Progra~1\TWH\apps\pe2\v110\misc\source\probsummary.xml" />. 

<incident-file name= 
"C:\Progra~1\TWH\apps\pe2\v110\misc\source\incidents.xml" />. 
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3 For each source Change Request file you intend to transform and insert into 
the Warehouse, add the following line to the sd_cfg.xml file anywhere 
between the <configuration> and </configuration> tags: 

<change-file name="fully_qualified_source_filename" /> 

where "fully_qualified_source_filename" (including the double quotes) is 
the full path of the source file. 

For Windows add:

<change-file name= 
"C:\Progra~1\TWH\apps\pe2\v110\misc\source\cm3r.xml" />. 

4 For the states file, add the following line to the sd_cfg.xml file anywhere 
between the <configuration> and </configuration> tags:

<state-machine-file name="fully_qualified_source_filename" /> 

where "fully_qualified_source_filename" (including the double quotes) is 
the full path of the source file. 

For Windows add:

<state-machine-file name= 
"C:\Progra~1\TWH\apps\pe2\v110\misc\source\change_states.xml" />. 

Note: This path and filename may vary with your installation. 

5 For the XML file containing the configuration codes, add the following line 
to the sd_cfg.xml file anywhere between the <configuration> and 
</configuration> tags: 

<sd-codes name="fully_qualified_config_filename" /> 

where "fully_qualified_config_filename" (including the double quotes) is the 
full path of the source configuration file. 

For Windows add a path and filename such as: 

<sd-codes name= 
"C:\Progra~1\TWH\apps\pe2\v110\misc\source\sd_config.xml" />.

Note: This path and filename may vary with your installation. 

6 When the warehouse pack runs, it creates the target XML (cdw.xml). 
Peregrine recommends that you use the default path or target file name, but 
you can change it if necessary. 

To change the path or target file name, edit the following line in the 
sd_cfg.xml file: 

<cdw-file name="fully_qualified_target_filename" />
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where "fully_qualified_target_filename" (including the double quotes) is the 
full path of the source file. 

The example:

<cdw-file name= 
"C:\Progra~1\TWH\apps\pe2\v110\misc\target\myCDW.xml" />

renames the target central data warehouse XML to the value entered in the 
sd_cfg.xml file. 

The new name has _<timestamp> appended to the name with the same .xml 
extension. 

Note: If your source files include a large number of records (more than 175 
records), the ETL divides the file into smaller files. Each smaller file has 
_<n> appended to its filename, where <n> is an index to the file.

7 Search the sd_cfg.xml file for spaces in paths and filenames, and remove 
them. For example, replace all instances of Program Files with Progra~1.

8 Open the change_states.xml file and confirm that the path to the 
sd_states.dtd file is correct. The path to the file is:

C:\Progra~1\TWH\apps\pe2\v110\misc\source\change_states.xml 

For Windows, the correct default sd_states.dtd path would be: 

<!DOCTYPE ProcessDefinition SYSTEM 
"C:\Progra~1\TWH\apps\pe2\v110\misc\dtds\sd_states.dtd">

The ETL installation and configuration is now complete. You should find the 
following Data Source and Data Target objects in your DB2 Data Warehouse 
Center, under Warehouse sources and Warehouse Targets respectively.

Data Sources: PE2_TWH_CDW_Source

Data Targets: PE2_TWH_CDW_Target. 

Also, the CDW database (TWH_CDW) should contain the following tables 
in .../instances/DB2/TWH_CDW/Tables:

STAGE_COMP STAGE_MSMT

STAGE_COMPATTR STAGE_MSMTRUL

STAGE_COMPRELN STAGE_MSMTTYP

STAGE_MGRPMBR
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Multiple data centers
After you install the warehouse pack, you can configure Tivoli Enterprise 
Data Warehouse to separate data for multiple data centers. To configure this, 
you create SQL scripts with the following values: 

For more information see Installing and Configuring Tivoli Enterprise Data 
Warehouse.

After the initial configuration for multiple data centers, modify the tables 
when adding or removing data centers.

Multiple customer environments
After you install the warehouse pack, you can configure Tivoli Enterprise 
Data Warehouse to separate data for the multiple customer environments. 
To configure this, you create SQL scripts with the following values: 

For more information see Installing and Configuring Tivoli Enterprise Data 
Warehouse.

After the initial configuration of multiple customer environments, you 
modify the tables when adding or removing customers.

Information for scripts Value or location 

Field in source data Fully qualified host name 

Name of lookup table SD.centr_lookup table 

Name of center list TWG.Centr 

Information for scripts Value or location 

Field in source data Fully qualified host name 

Name of lookup table SD.cust_lookup table 

Column to use for lookup <select either Cust_ID or Cust_Acct_Cd> 

Name of customer list TWG.Cust 
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Uninstalling the warehouse pack 
To uninstall the warehouse pack, use the warehouse pack uninstall process. 
See Installing and Configuring Tivoli Enterprise Data Warehouse for details.

To uninstall the warehouse pack:

Uninstall the warehouse pack as described in Installing and Configuring Tivoli 
Enterprise Data Warehouse. During this process, you provide a 
three-character identifier for the warehouse pack. The three-character 
identifier of this warehouse pack is pe2.

The uninstallation process removes the application-specific tables, but the 
data in the central data warehouse database remains and is still usable by 
other applications.

Configuring the Connect-It scenario
To configure the Connect-It scenario, you configure each of the following 
three scenarios:

SC5Xprobsummary.to.Tivoli Enterprise Data Warehouse.scn

SC5Xincidents.to.Tivoli Enterprise Data Warehouse.scn 

SC5Xcm3r.to.Tivoli Enterprise Data Warehouse.scn

After installation, the scenarios are located in:  
C:\Program Files\Peregrine\ConnectIt\scenario\SCtoTEDW\.

This following example illustrates one way to perform the configuration. 
However, your actual configuration may vary. 

To configure a scenario:

1 Start the ServiceCenter server. 

2 Open the scenario in Connect-It. (Use File > Open, or double-click the 
scenario.

3 Check Advanced Configuration the Tools menu.

4 From the Scenario menu, select User Formats.

5 Confirm that there is a line that points to the date.usr file. For the example, 
it should be located under the line: 
C:\Program Files\Peregrine\ConnectIt\config\shared\usrfrmt\usrfrmt.usr.
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6 If there is no line listing date.usr as a user format, add a line indicating the 
path of the date.usr file:  
C:\Program Files\Peregrine\ConnectIt\scenario\SCtoTEDW\date.usr

7 Configure the ServiceCenter Connector.

a Right-click on the ServiceCenter connector, and select Configure 
connector.

b Click Next.

c Enter the ServiceCenter Server name, Login, and Password information.

d Click Test to confirm the connection to your ServiceCenter instance. 

If the test was successful, close the test window. If the test was not 
successful, close the test window, correct the information, and test the 
connection again. Make sure that the ServiceCenter server is running 
during the entire process.

e After you can connect successfully, click Next.

f Set the database description file to point to the location of the 
scdb51TEDW.cfg file. For the example use:  
C:\Program Files\Peregrine\ConnectIt\config\sc\scdb51TEDW.cfg.

g Configure the other settings as appropriate. 

h Click Finish.

8 Configure the XML connector.

a Right-click the XML connector and select Configure Connector.

b Click Next.

Note: The scenario assumes that one machine or a shared file system places 
the XML documents into the source directory.

c Select a connection protocol. For example, select Local/Network file (s), 
and click Next.

d On the Choose a file or folder screen:

Choose Write the documents to a single file. 

Enter the source directory of the warehouse pack in the Name of the 
folders text box. For example, the default windows directory would be: 
C:\Program Files\TWH\apps\pe2\v110\misc\source\.

e On the Behavior between two sessions screen, select Append to the same 
file and click Next.
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f On the Choose a DTD/XSD screen, browse to the correct .dtd file. 

For SC5Xprobsummary.to.Tivoli Enterprise Data Warehouse.scn point 
to incident.dtd. 

SC5Xincidents.to.Tivoli Enterprise Data Warehouse.scn point to 
incident.dtd. 

For SC5Xcm3r.to.Tivoli Enterprise Data Warehouse.scn point to 
change.dtd.

For example point to 
C:\Program Files\Peregrine\ConnectIt\scenario\SCtoTEDW\ 
<Change.dtd> ( or <incident.dtd>.)

g Select Do not use reference to the resulting DTD in the XML file.

h Select Publish a document type for each root element found in the 
DTD/XSD.

i Select other settings if necessary.

j Click Finish to complete setting up the XML connector.

9 Configure the Mapping connector.

a Right-click the Mapping connector, and select Edit a mapping from the 
drop-down menu.

b Double-click the mapping that you want to edit. 

c When the Edit Mapping dialog box opens, right-click the port and select 
Edit Mapping. 
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Note: There can be multiple instances of the ServiceCenter server running 
on the same machine. A port and hostname uniquely identify the 
ServiceCenter instance. 

d Enter the port for the correct instance of ServiceCenter in the text editor 
and click OK.

e Right-click host name, and select Edit Mapping.

f Enter the hostname for the correct instance of ServiceCenter in the text 
editor and click OK.

g Click Finish.
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3 T
ransforming ServiceCenter Data
This chapter describes how to transfer data, and how to maintain the data 
after you load it.

Topics in this chapter include:

Testing the Connect-It scenarios on page 54

Testing the ETL processes on page 55

Transforming and loading data on page 59

Maintenance on page 63

Troubleshooting on page 64
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Testing the Connect-It scenarios

You can run the Connect-It scenarios on a small subset of records to check 
whether XML files were created successfully. 

Create a subset of records for testing
To create a subset of converted records:

1 Start Connect-It! 

2 Select Options from the Edit menu.

3 In the Options window, open Display, and check Number of documents to 
produce in a test production of documents.

4 Enter the number of documents. In this example, only 20 records will be 
converted.

5 Click OK to save and exit.

Important: Be sure to remove this selection when moving into production! 
For more information, see Remove the limit on the number of 
records converted by Connect-It on page 59. 

Test the scenarios by running them without scheduling them.
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To run a scenario without scheduling it:

1 Start ServiceCenter.

2 Open the scenario in Connect-It using one of the following methods:

Start Connect-It, and select the scenario using File > Open.

Double-click the scenario in Windows Explorer.

3 Run the scenario using one of the following methods:

Select Tools > Produce now.

Press F5.

Click Produce now. 

After all three scenarios have been run, you can examine your test data in the 
XML files.

Testing the ETL processes

If you run tests on your production system, your test data will be copied to 
your production system. To avoid this, test the ETL processes on a test 
system. 

Change paths and filenames in sd_cfg.xml
You can change the configuration files to point files that contain test data.

To change the path or filename in the configuration files:

1 Open the following file for editing: 
<TWH_TOPDIR>\apps\pe2\v110\misc\transforms\sd_cfg.xml

Note: The sd_cfg.xml file should contain two lines starting with the 
<incident-file name= parameter. One is for incident data and the 
other is for probsummary data.

2 For the incidents file, edit the following line in the sd_cfg.xml file: 

<incident-file name="fully_qualified_source_filename" /> 

where "fully_qualified_source_filename" (including the double quotes) is the 
full path of the source file. 

3 For the probsummary file, edit the following line in the sd_cfg.xml file: 

<incident-file name="fully_qualified_source_filename" /> 
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where "fully_qualified_source_filename" (including the double quotes) is the 
full path of the source file. 

4 For the change file, add the following line to the sd_cfg.xml file:

<change-file name="fully_qualified_source_filename" /> 

where "fully_qualified_source_filename" (including the double quotes) is the 
full path of the source file. 

Run the processes manually
Run the ETL processes manually to test the transfer of data from the XML 
files into the CDW. For more information, see Installing and Configuring 
Tivoli Enterprise Data Warehouse.

To run the processes manually:

1 Open the IBM DB2 Control Center. (Go to Start > Programs > IBM db2 > 
Control Center.) 

2 From the Tools menu, select Data Warehouse Center.

3 Log in. 

4 Under Warehouse, open Subject Areas.

5 Set each step in each of the processes provided by the warehouse pack to Test 
mode.

a Under Processes, select PE2_c05_Load_Service_Desk_Data_Process. 

This process moves data from ServiceCenter to DB2. For more 
information, see PE2_c05_Load_Service_Desk_Data_Process on page 21.

b Highlight the Process steps:

PE2_c05_s010_Load_Into_Staging

PE2_c05_s020_Comp

PE2_c05_s030_Msmt 
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c Right-click the process steps and select Test from the Mode menu. 

Under Processes, select PE2_c10_Purge_Comps_And_Attrs. 

This process purges the comps table and the attrs table used in the ETL 
processing. For more information, see PE2_c10_Purge_Comps_And_Attrs 
on page 21.

d Highlight the process step PE2_c10_s010_Purge_Comps.

e Right-click the process step and select Test from the Mode menu. 

Note: ServiceCenter Incidents, Calls, and Changes are all stored in the same 
Tivoli Enterprise Data Warehouse file. 

6 Run the test.

a Under Processes, select PE2_c05_Load_Service_Desk_Data_Process. 

This process moves data from ServiceCenter to DB2. For more 
information about this process, see 
PE2_c05_Load_Service_Desk_Data_Process on page 21.

b Highlight the Process steps:

PE2_c05_s010_Load_Into_Staging

PE2_c05_s020_Comp

PE2_c05_s030_Msmt 
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c Right-click the process steps and select Test. 

Under Processes, select PE2_c10_Purge_Comps_And_Attrs. 

This process drops and recreates all XML staging tables used in the ETL 
processing. For more information, see PE2_c10_Purge_Comps_And_Attrs 
on page 21.

d Highlight the process step PE2_c10_s010_Purge_Comps.

e Right-click the process step and select Test. 

Note: ServiceCenter Incidents, Calls, and Changes are all stored in the same 
Tivoli Enterprise Data Warehouse file. 

After the transfer is complete, the test data should be visible in DB2.
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Transforming and loading data

To transform and load your data:

Step 1 Remove the limit on the number of records converted by Connect-It, as 
described in the following section. Perform this step only if you set such a 
limit, as described in the section Create a subset of records for testing on 
page 54.

Step 2 Schedule Connect-It scenarios. The steps required are found in the section 
that begins on page 60. This is a required step.

Step 3 Change the paths and filenames in the sd_cfg.xml file, as described in the 
section on page 60. Perform this step only if you changed the paths or 
filenames.

Step 4 Set the ETL Processes to production mode. This is described in the section on 
page 61. Perform this step only if you set the processes to test mode.

Step 5 Schedule the ETL processes. This is described in the section on page 62. This 
is a required step.

Remove the limit on the number of records converted by 
Connect-It 

If you set a limit on the number of ServiceCenter records that are converted, 
remove the limit before cutover to production. 

Note: The steps for setting a limit for testing were described in the section 
Create a subset of records for testing on page 54.

To remove the limit on the number of records to be converted:

1 Start Connect-It Scenario Builder.

2 Select Options from the Edit menu.

3 In the Options window, open Display, and remove the check by Number of 
documents to produce in a test production of documents.

4 Click OK to save and exit.
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Schedule the Connect-It scenarios
You can schedule Connect-It scenarios to run automatically, as frequently as 
necessary to handle the workload in your organization. 

To maximize efficiency, co-ordinate the Connect-It run schedule with the 
schedule of your warehouse processes. If Connect-It scenarios run multiple 
times before the warehouse processes run, the processes will create duplicate 
records in DB2, and duplicate key errors as well. 

For information on how to schedule Connect-It scenarios, see the Connect-It 
User’s Guide.

Change paths and filenames in sd_cfg.xml
During testing you might have changed the configuration file to point to test 
data. If so, you now change the configuration file to point to files that contain 
actual production data.

To change the path or filename in the configuration files:

1 Open the file <TWH_TOPDIR>\apps\pe2\v110\misc\transforms 
\sd_cfg.xml for editing.

2 For the incidents file, add the following line in the sd_cfg.xml file anywhere 
between the <configuration> and </configuration> tags: 

<incident-file name="fully_qualified_source_filename" /> 

where "fully_qualified_source_filename" (including the double quotes) is the 
full path of the source file. 

3 For the probsummary file, add or edit the following line in the sd_cfg.xml file 
anywhere between the <configuration> and </configuration> tags: 

<incident-file name="fully_qualified_source_filename" /> 

where "fully_qualified_source_filename" (including the double quotes) is the 
full path of the source file. 

4 For the change file, add the following line to the sd_cfg.xml file anywhere 
between the <configuration> and </configuration> tags:

<change-file name="fully_qualified_source_filename" /> 

where "fully_qualified_source_filename" (including the double quotes) is the 
full path of the source file. 
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Change the path and file names in the state files
During the testing process, you may have changed the state file to point to 
files that contain test data. If so, change the states file to point to the files that 
contain actual production data.

1 Open the change_states.xml file and, if necessary, edit the path to the file 
sd_states.dtd. 

C:\Program Files\Twh\apps\pe2\v110\misc\source\change_states.xml

For Windows, the path default sd_states.dtd path is: 

<!DOCTYPE ProcessDefinition SYSTEM" 
C:\Progra~1\TWH\apps\pe2\v110\misc\dtds\sd_states.dtd">

Set the ETL processes to production mode
During your testing process, you may have set the ETL process steps to Test 
mode. If you did, you must now change them to production mode.

To set the processes to production mode:

1 Open the DB2 Control Center. (Go to Start > Programs > IBM db2 > 
Control Center.) 

2 Set each step in each of the processes provided by the warehouse pack to 
Production mode. 

The processes are located in the Warehouse under Subject Areas > 
PE2_Service_Desk_ETL_Subject_Area > Processes.

PE2_c05_Load_Service_Desk_Data_Process contains three steps.  
For more information about this processes, see 
PE2_c05_Load_Service_Desk_Data_Process on page 21. 

PE2_c10_Purge_Comps_And_Attrs contains one step.  
For more information about this processes, see 
PE2_c10_Purge_Comps_And_Attrs on page 21.
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Schedule the ETL processes
Specify dependencies between processes and schedule processes that are to 
run automatically. The processes for the warehouse pack are located in the 
PE2_ServiceDesk_ETL_Subject_Area subject area. 

To schedule the processes:

1 Link the steps to run in the following order:

a PE2_c05_Load_Service_Desk_Data_Process

PE2_c05_s010_Load_Into_Staging

PE2_c05_s020_Comp

PE2_c05_s030_Msmt

b PE2_c10_Purge_Comps_And_Attrs

PE2_c10_s010_Purge_Comps

2 Schedule the processes to run regularly, selecting a frequency appropriate for 
your load. Co-ordinate the Connect-It schedule with the schedule of the 
warehouse processes. If the Connect-It scenarios run multiple times before 
the warehouse processes run, the processes will create duplicate records in 
DB2, and duplicate key errors will result. 

For information on how to schedule warehouse processes, see Installing and 
Configuring Tivoli Enterprise Data Warehouse. 
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Maintenance

Pruning the TWH_CDW database
To manage the high volume of data, use the prune table to delete data. 
Pruning data from the measurement (Msmt) table combines triggers and the 
CDW_C05_PurgeMsmt_Process warehouse process. The 
PE2.Prune_Msmt_Log table keeps a history of data deletion.

Schedule how often you want the CDW_C05_PurgeMsmt_Process 
warehouse process to run (for example, weekly or monthly). By default, the 
CDW_C05_PurgeMsmt_Process warehouse process prunes all Peregrine 
ServiceCenter application data over one year old. 

To modify the default date duration value, run the following SQL statement, 
where X is a date duration in the format yyyymmdd (for example, X = 
00000108, which represents 0000 years, 01 months, 08 days).

UPDATE TWG.Prune_Msmt_Control
SET PMSMTC_AGE_IN_DAYS = X
WHERE TMSUM_CD = 'H' AND MSRC_CD = 'PE2'

Note: This warehouse uses an addition pruning table along with that 
provided in other warehouse packs. The process step 
PE2_c10_Purge_Comps_And_Attrs uses that additional table.

Pruning the Central data warehouse database
The prune measurement control table (Prune_Msmt_Control) governs the 
pruning of data from the warehouse. By default all data older than one year 
is deleted when the CDW_c05_Prune_and_Mark_Active process runs.

Measurement data is deleted from the Msmt table once a year. This is based 
on the age specified in the PMsmtC_Age_In_Days column.
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Extraction control (table Extract_Ctrl)
The warehouse pack does insert a record into the extract control table, the 
table is not used. Extract control is used for reading out of a database. This 
warehouse pack does not read directly from the database. 

Troubleshooting

If the correct data do not appear in DB2, examine the cm3r.xml, 
probsummary.xml, or incidents.xml files to determine whether the correct 
conversion is taking place. See Mapping ServiceCenter data on page 23 for 
data mapping information.

Tivoli Enterprise Data Warehouse problems
For common problems and solutions, see the Installing and Configuring 
Tivoli Enterprise Data Warehouse guide.

The Connect-It Message window

Message
The scenario was executed in test mode. No data was written to the 
destination.

Possible cause

The scenario has been set to Test mode.

Solution

From the Connect-It Scenario menu, remove checkmark beside Test mode.

ExtCtl_So
urce 
VARCHAR 
(120) 

ExtCtl_Tar
get 
VARCHAR 
(120) 

ExtCtl_Fro
m_RawSe
q CHAR 
(10) 

ExtCtl_to_
RawSeq 
CHAR (10) 

ExtCtl_Fro
m_IntSeq 
BIGINT 

ExtCtl_To_
IntSeq 
BIGINT 

ExtCtl_Fro
m_DtTm 
TIMESTAM
P 

ExtCtl_To_
DtTm 
TIMESTAM
P 

'PE2_SRC' 'TWH_CD
W'

x'00000000
000000000
000'

x'00000000
000000000
000'

0 0 '1970-01-0
1-00.00.00.
000000'

'1970-01-0
1-00.00.00.
000000'
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The Connect-It log

Message
Cannot open file C:\...\tracking.idx. (Errno=3) The system cannot find the 
path specified.

Possible cause

The path to the tracking file is not correct.

To fix this problem:

1 From the Connect-It Log menu, select Configure Document log.... 

2 Enter a valid page for the file in the Tracking line file text box. 

Message
Unable to connect to the server to get the version number.

Possible cause 1

ServiceCenter server is not running.

To fix this problem:

Start the ServiceCenter server. 

Possible cause 2

The ServiceCenter connector is looking in the wrong place.

To fix this problem:

1 Right-click the ServiceCenter connector, and select Configure Connector 
from the drop-down menu.

2 Step through the process. When prompted, enter the correct server name in 
the Server text box.

Message
Connection refused: Invalid password for login <your login>.

Possible cause

The connector is using the wrong password.
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To fix this problem:

Right-click the ServiceCenter connector, and select Configure Connector 
from the drop-down menu.

Step through the process. When prompted, enter the correct password in the 
Password text box.

Message
Connection refused: Login ‘your login’ unknown.S

Possible cause

The connector is using the wrong login.

To fix this problem:

1 Right-click the ServiceCenter connector, and select Configure Connector 
from the drop-down menu.

2 Step thought the process. When prompted, enter the correct server name in 
the Server text box.

The sd_execute.log
The sd_execute.log is a useful when testing the 
PE2_c05_s010_Load_Into_Staging step. It is located in the C:\Program 
Files\sqllib\logging\ directory.

Error Message

'C:\Program' is not recognized as an internal or external command, operable 
program or batch file.

Possible cause

The there is a space in a path given in sd_cgf.xml. 

To fix this problem:

In the sd_cfg.xml file, replace all cases of <C:\Program Files>, with 
<C:\Progra~1>.

The sd_cfg.xml file is located in the 
<TWH_TOPDIR>\apps\pe2\v110\misc\transforms\ directory. 
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Error Message
file:///C:/Progra~1/TWH/apps/pe2/v110/misc/transforms/sd_transform.xsl
; Line #36; Column #60; Cannot load requested doc: 
<C:\TWH\apps\pe2\v110\misc\dtds\sd_states.dtd> (The system cannot 
find the path specified.)

Possible cause

The path to the sd_states.dtd file is incorrect in the states file. 

To fix this problem:

Correct the path for sd_states.dtd in the appropriate XML file. 

For Windows, the correct default path is:  
C:\Program Files\Twh\apps\pe2\v110\misc\source\change_states.xml

Duplicate key errors
Possible cause

The Connect-It scenarios ran more than once before the warehouse 
processes ran. The same record was added to the XML file more than once. 
When the warehouse processes ran, they transferred duplicate records to 
DB2. 

To fix this problem:

Co-ordinate the Connect-It schedule with the schedule of the warehouse 
processes. 

For information on how to schedule warehouse processes, see Installing and 
Configuring Tivoli Enterprise Data Warehouse. For information on how to 
schedule Connect-It scenarios, see the Connect-It User’s Guide.
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CHAPTER
4 C

I

entral Data Warehouse Schema 
mplementation
This chapter provides information on what data should go into the incident 
and change database tables and about what type of data goes into the fields.

Before reading this chapter, read about central data warehouse schema in 
Enabling an Application for Tivoli Enterprise Data Warehouse. That document 
defines the content of each table and explains the relationships between the 
tables in this guide.

Topics in this chapter include:

Sample Incident on page 70

Sample Change request on page 72

Component configuration on page 75

Component measurement on page 98
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Sample Incident

On November 4th...

November 4th, at 9:42 AM (open time) Ted, the mortgage clerk, opened a severity 1 
Incident (1088) stating that he cannot login to the mortgage application.

November 4th, at 10:20 AM (accept) Alice, the Senior IT Administrator, responded to 
Ted's incident by saying that they are investigating what the cause is.

November 4th, at 11:35 AM Marty, the Security Administrator, sees a problem (with 
the LDAP database) related to Ted's incident. Marty completes this fix.

November 4th, at 12:40 PM Alice leaves voicemail for Ted, who was out to lunch, 
saying that the problem was repaired. Alice closes the incident.

Incident details
These attribute values describe the sample Incident. 

Note: A blank Value means that this information is not valid for this 
Incident. 

Table 4-1:  Incident attribute values

Attribute Value

PRIORITY 2

IP_HOSTNAME

LAST_IP_ADDRESS

SEVERITY 1

SD_USERID Teddy (on SD_USER component)

SD_STATUS_CODE Accepted

CONTACT Ted Jones

COMPANY BIGBANK

E_MAIL_ADDRESS teddy@bigbank.com

PHONE_NUMBER 111-222-3333 (on SD_USER component)

CELL_PHONE_NUMBER 444-555-5555 (on SD_USER component)
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SITE Moorefield

SD_SITE_CATEGORY Remote

DIVISION 46

DEPARTMENT VISA

OWNER Alice

SD_SYSTEM Business Applications

SD_COMPONENT Security

SD_ITEM Mortgage Application

SD_MODULE

SD_PRODUCT_TYPE Business application

SD_PROBLEM_TYPE Client specific

SD_CAUSE_CODE Fault

SD_ASSETS_AFFECTD

SD_RELATED_CHNGS

DESCRIPTION Ted cannot login to the mortgage application

ABSTRACT login to the mortgage application fails

OPEN_TIMESTAMP Nov 4th 9:42 AM

FIX_TIME

CLOSE_TIMESTAMP November 4th, at 2:35

SD_USER_TYPE Contact (against SD_USER)

SD_ASSIGN_GROUP Software

FIRST_NAME Ted (on SD_USER component)

LAST_NAME Jones (on SD_USER component)

EMPLOYEE_NUMBER 217-45-9873 (on SD_USER component)

ASSIGNEE_NAME Marty

TYPE Call

Table 4-1:  Incident attribute values

Attribute Value
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Sample Change request

On November 12th...

November 12th, at 9:42 AM Linda, the director of Lending Services opens a change 
(C1235) request to have all of their Lotus Notes clients upgraded from 4.6 to 5.0.

December 9th, at 10:20 AM Jerry, the Lending Services Coordinator, finishes 
evaluating Linda's request and hands it off to Alice to make a recommendation.

December 13th, at 11:35 AM Alice approves the request and hands the request now 
to James, the applications specialist, to perform the upgrade.

December 17th, at 11:35 AM James begins upgrading all of Linda's departments Lotus 
Notes clients.

December 23rd, at 11:40 PM James completes upgrading all of Lending Services 
Lotus Notes clients.

Change details
These attribute values describe the sample Change request. 

Note: A blank Value means that this information is not valid for this change 
request.

Table 4-2:  Change attribute values

Attribute Value

CR_PRIORITY 3

IP_HOSTNAME

LAST_IP_ADDRESS

SD_USERID LindaD (on SD_USER component)

CONTACT Linda

COMPANY BIGBANK

E_MAIL_ADDRESS TheDirector@bigbank.com

PHONE_NUMBER 123-987-8888

CELL_PHONE_NUMBER 123-596-6966
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DIVISION ABC

DEPARTMENT BVDA

SD_SYSTEM Application

SD_COMPONENT Lotus Notes

SD_ITEM Client

SD_MODULE

SD_ASSETS_AFFECTD A1234.A2345.A3456.A4567.A5678.A6789

SD_RELATED_INCS

DESCRIPTION Upgrade all Lotus Notes clients from 4.6 to 5.0 for 
department BVDA. 

ABSTRACT Lotus Notes clients upgraded from 4.6 to 5.0 

SD_RISK_LEVEL 2

CR_PLAN_START December 17th 00:00:00

CR_ACT_START December 17th, at 11:35 AM

CR_PLAN_OUTAGE_ST

CR_ACT_OUTAGE_ST

CR_PLAN_END December 19th 00:00:00

CR_ACT_END December 23rd 11:40 PM

CR_PLAN_OUTAGE_ED

CR_ACT_OUTAGE_ED

APPROVAL_TIMESTAP December 13th 11:35 AM

CR_REQUEST_DATE November 12th 9:42 AM

CR_COMPLETE_DATE December 23rd 11:40 PM

CR_APP_ACTION Approved

APPROVER_NAME Alice Mike John

CR_COMPLETION_CD 1

OPEN_TIMESTAMP November 12th, at 9:42

CR_BACKOUT_PLAN Switch back to Notes 4.6

Table 4-2:  Change attribute values

Attribute Value
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Sample Change task data

SD_COORDINATOR_NM Jerry

CR_START_DELAY 11 hours, 35 minutes

CR_END_DELAY 4 days, 23 hours, 40 minutes

SD_USER_TYPE  (Requester - on SD_USER component)

FIRST_NAME Linda (on SD_USER component)

LAST_NAME Jeffrey (on SD_USER component)

EMPLOYEE_NUMBER 217-974-0000 (ON SD_USER component)

ASSIGNEE_NAME Jimbob

CR_APP_STATUS Approved

CR_STATUS_CODE Open

Attribute Value

CR_TASK_PHASE Update client

DESCRIPTION Update client machine

CR_PLAN_START December 17th 00:00:00

CR_PLAN_END December 18th 00:00:00

CR_TASK_STATUS Initial

Table 4-2:  Change attribute values

Attribute Value
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C
C

CompTyp_End_ 
DtTm TIMESTAMP

S 9999-01-01-00.00.0
0.000000

I 9999-01-01-00.00.0
0.000000

C 9999-01-01-00.00.0
0.000000

S 9999-01-01-00.00.0
0.000000

C 9999-01-01-00.00.0
0.000000
omponent configuration

omponent type (table CompTyp)

* Note - Reserved. This column is not available in Tivoli Enterprise Data Warehouse

ompTyp_Cd  
HAR (17)

CompTyp_Parent_ 
Cd CHAR (17)

CompTyp_Nm  
VARCHAR (120)

CompTyp_Strt_ 
DtTm TIMESTAMP

MSrc_Cd* CHAR 
(6)

ERVICE_DESK NULL Service Desk 2002-04-04-00.00.0
0.000000

MODEL1

NCIDENT NULL Incident 2002-04-04-00.00.0
0.000000

MODEL1

HANGE_REQUEST NULL Change Request 2002-04-04-00.00.0
0.000000

MODEL1

D_USER NULL Service Desk User 2002-04-04-00.00.0
0.000000

SDESK1

R_TASK NULL Change Request Task 2002-04-04-00.00.0
0.000000

SDESK1
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Comp_Ds
VAR 
CHAR 
(254)

MSrc_Cd
* CHAR 
(6)

 

0

PE2

 

0

Login to 
the 
mortgage 
applica- 
tion fails

PE2

 

0

PE2

 

0

Lotus 
Notes 
clients 
upgraded 
from 4.6 
to 5.0

PE2

 

0

PE2

 

0

Update 
client 
machine

PE2
Component (table Comp)

* Note - Reserved. This column is not available in Tivoli Enterprise Data War

Comp_ ID 
INTEGER

CompTy
p_Cd 
CHAR 
(17)

Centr_Cd 
CHAR (6)

Cust_ID 
INTEGER

Comp_ 
Corr_ID 
INTEGER

Comp_ 
Nm 
VARCHA
R (254)

Comp_C
orr_Val 
VARCHA
R (254)

Comp_St
rt_DtTm 
TIME 
STAMP

Comp_En
d_DtTm 
TIME 
STAMP

1 SERVICE
_DESK

CDW 1 GoTerps.
9847

2002-04- 
04-00.00.
00.000000

9999-01-
01-00.00.
00.00000

2 INCIDEN
T

CDW 1 I1088 2002-04- 
04-00.00.
00.000000

9999-01-
01-00.00.
00.00000

3 SD_USER CDW 1 Ted Jones 2002-11- 
04-00.00.
00.000000

9999-01-
01-00.00.
00.00000

4 CHANGE
_REQUE
ST

CDW 1 C1235 2002-11-1
2-00.00.0
0.000000

9999-01-
01-00.00.
00.00000

5 SD_USER CDW 1 Linda 2002-11- 
12-00.00.
00.000000

9999-01-
01-00.00.
00.00000

6 CR_TAS
K

CDW 1 1 2002-11- 
12-00.00.
00.000000

9999-01-
01-00.00.
00.00000
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 (120)

C
C

_DtTm TIMESTAMP

I 0.00.00.000000

S 0.00.00.000000

S 0.00.00.000000

C 0.00.00.000000

C 0.00.00.000000

C 0.00.00.000000

C
ID

tTm Msrc_Cd
* CHAR 
(6)

1 00.000000 PE2

2 00.000000 PE2
omponent relationship type (table RelnTyp)

omponent relationship rule (table RelnRul)

omponent relationship (table CompReln)
The REPRTS and the CAUSES relationships may not be implemented.

RelnTyp_Cd CHAR (6) MSrc_Cd CHAR (6) RelnTyp_Nm VARCHAR

CAUSES MODEL1 Causes Relationship

PCHILD MODEL1 Parent Child Relationship

ompTyp_Source_ 
d CHAR (17)

CompTyp_Target_ 
Cd CHAR (17)

RelnTyp_Cd 
CHAR (6)

RelnRul_Strt_DtTm TIMESTAMP RelnRul_End

NCIDENT SD_USER PCHILD 2002-04-04-00.00.00.000000 9999-01-01-0

ERVICE_DESK INCIDENT PCHILD 2002-04-04-00.00.00.000000 9999-01-01-0

ERVICE_DESK CHANGE_REQUEST PCHILD 2002-04-04-00.00.00.000000 9999-01-01-0

HANGE_REQUEST INCIDENT CAUSES 2002-04-04-00.00.00.000000 9999-01-01-0

HANGE_REQUEST SD_USER PCHILD 2002-04-04-00.00.00.000000 9999-01-01-0

HANGE_REQUEST CR_TASK PCHILD 2002-04-04-00.00.00.000000 9999-01-01-0

ompReln_ 
 INTEGER

Comp_Source_ 
ID INTEGER

Comp_Target_ 
ID INTEGER

RelnTyp_ 
Cd CHAR 
 (6)

CompReln_Strt_DtTm  
TIMESTAMP

CompReln_End_D
TIMESTAMP

1 2 PCHILD 2002-04-04-00.00.00.000000 9999-01-01-00.00.

2 3 PCHILD 2002-04-04-00.00.00.000000 9999-01-01-00.00.
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-00.00.00.000000 PE2

-00.00.00.000000 PE2

-00.00.00.000000 PE2

_End_DtTm 
P

Msrc_Cd
* CHAR 
(6)

) 
* Note - Reserved. This column is not available in Tivoli Enterprise Data War

Attribute type (table AttrTyp)

3 1 4 PCHILD 2002-04-04-00.00.00.000000 9999-01-01

4 4 5 PCHILD 2002-04-04-00.00.00.000000 9999-01-01

5 4 6 PCHILD 2002-04-04-00.00.00.000000 9999-01-01

CompReln_ 
ID INTEGER

Comp_Source_ 
ID INTEGER

Comp_Target_ 
ID INTEGER

RelnTyp_ 
Cd CHAR 
 (6)

CompReln_Strt_DtTm  
TIMESTAMP

CompReln
TIMESTAM

AttrTyp_Cd CHAR (17) MSrc_Cd* CHAR (6) AttrTyp_Multi_ 
Val* CHAR (1)

AttrTyp_Nm VARCHAR (120

PRIORITY MODEL1 N Priority 

CR_PRIORITY SDESK1 N Change Request Priority

IP_HOSTNAME MODEL1 N IP Hostname

LAST_IP_ADDRESS MODEL1 N Last IP Address

SEVERITY MODEL1 N Severity

SD_USERID SDESK1 N User Identification (User ID)

CLOSED_BY MODEL1 N Closed By

IMPACT MODEL1 N Impact

DUE_DATE MODEL1 N Due Date

FIRST_CALL_RES MODEL1 N First Call Resolution

SD_STATUS_CODE SDESK1 N Service Desk Status Code

CR_STATUS_CODE SDESK1 N Change Request Status Code
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A

ONTACT MODEL1 N Contact

D_REPORTD_BY_NM SDESK1 N Reported By

OMPANY MODEL1 N Company

_MAIL_ADDRESS MODEL1 N E-Mail

HONE_NUMBER MODEL1 N Phone Number

ELL_PHONE_NUMBER MODEL1 N Cell Phone Number

ITE MODEL1 N Site

D_SITE_CATEGORY SDESK1 N Site Category

IVISION MODEL1 N Division

EPARTMENT MODEL1 N Department

WNER MODEL1 N Owner

D_SYSTEM SDESK1 N Service Desk System 

D_COMPONENT SDESK1 N Service Desk Component

D_ITEM SDESK1 N Service Desk Item

D_MODULE SDESK1 N Service Desk Module

D_PRODUCT_TYPE SDESK1 N Product Type

D_PROBLEM_TYPE SDESK1 N Problem Type 

D_CAUSE_CODE SDESK1 N Incident Cause Code

D_ASSETS_AFFECTD SDESK1 Y Assets Affected

D_RELATED_INCS SDESK1 Y Related Incidents

D_RELATED_CHNGS SDESK1 Y Related Changes

ttrTyp_Cd CHAR (17) MSrc_Cd* CHAR (6) AttrTyp_Multi_ 
Val* CHAR (1)

AttrTyp_Nm VARCHAR (120) 
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 Date and Time

ate and Time

ge Start Date and Time

e Start Date and Time

Date and Time

ate and Time

ge End Date and Time

e End Date and Time

e Request

te

ions

) 
DESCRIPTION MODEL1 N Description

ABSTRACT MODEL1 N Abstract

SD_RISK_LEVEL SDESK1 N Request Risk Level

CR_PLAN_START SDESK1 N Change Request Planned Start

CR_ACT_START SDESK1 N Change Request Actual Start D

CR_PLAN_OUTAGE_ST SDESK1 N Change Request Planned Outa

CR_ACT_OUTAGE_ST SDESK1 N Change Request Actual Outag

CR_PLAN_END SDESK1 N Change Request Planned End 

CR_ACT_END SDESK1 N Change Request Actual End D

CR_PLAN_OUTAGE_ED SDESK1 N Change Request Planned Outa

CR_ACT_OUTAGE_ED SDESK1 N Change Request Actual Outag

APPROVAL_TIMESTAP MODEL1 N Approval Timestamp

CR_REQUEST_DATE SDESK1 N Requested Date for the Chang

CR_COMPLETE_DATE SDESK1 N Change Request Complete Da

CR_APP_ACTION SDESK1 Y Change Request Approval Act

APPROVER_NAME MODEL1 Y Approver Name

CR_COMPLETION_CD SDESK1 N Completion Code 

OPEN_TIMESTAMP MODEL1 N Open Timestamp

FIX_TIME MODEL1 N Fix Timestamp

CLOSE_TIMESTAMP MODEL1 N Close Timestamp

CR_BACKOUT_PLAN SDESK1 N Change Request Backout Plan

AttrTyp_Cd CHAR (17) MSrc_Cd* CHAR (6) AttrTyp_Multi_ 
Val* CHAR (1)

AttrTyp_Nm VARCHAR (120
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A

S

C tes)

C es)

S

S

F

L

E

A

T

C

C

C

C

A

C
(1

AttrRul_Dom_ 
Ind CHAR

S 000 Y

S 000 N
* Note - Reserved. These columns are not available in Tivoli Enterprise Data Wareho

ttribute rule (table AttrRul)

D_COORDINATOR_NM SDESK1 N Change Request Coordinator Name

R_START_DELAY SDESK1 N Change Request Start Delay (in minu

R_END_DELAY SDESK1 N Change Request End Delay (in minut

D_USER_TYPE SDESK1 Y User Type

D_ASSIGN_GROUP SDESK1 N Assignment Group

IRST_NAME MODEL1 N First Name

AST_NAME MODEL1 N Last Name

MPLOYEE_NUMBER MODEL1 N Employee Number

SSIGNEE_NAME MODEL1 N Assignee Name

YPE MODEL1 N Type

R_APP_STATUS SDESK1 N Change Request Approval Status

R_TASK_STATUS SDESK1 N Task Status

R_TASK_PHASE SDESK1 N Task Phase

R_TASK_DESC SDESK1 N Task Description

ttrTyp_Cd CHAR (17) MSrc_Cd* CHAR (6) AttrTyp_Multi_ 
Val* CHAR (1)

AttrTyp_Nm VARCHAR (120) 

ompTyp_Cd CHAR 
7)

AttrTyp_Cd CHAR (17) AttrRul_Strt_DtTm 
TIMESTAMP

AttrRul_End_DtTm 
TIMESTAMP

D_USER SD_USER_TYPE 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

D_USER FIRST_NAME 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000
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.00.000000 N

.00.000000 N

.00.000000 Y

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 Y

.00.000000 Y

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

m AttrRul_Dom_ 
Ind CHAR
SD_USER LAST_NAME 2002-04-04-00.00.00.000000 9999-01-01-00.00

SD_USER EMPLOYEE_NUMBER 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT SEVERITY 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT LAST_IP_ADDRESS 2002-04-04-00.00.00.000000 9999-01-01-00.00

SD_USER SD_USERID 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT IP_HOSTNAME 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT SD_STATUS_CODE 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST CR_STATUS_CODE 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT CONTACT 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST CONTACT 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT COMPANY 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST COMPANY 2002-04-04-00.00.00.000000 9999-01-01-00.00

SD_USER COMPANY 2002-04-04-00.00.00.000000 9999-01-01-00.00

SD_USER E_MAIL_ADDRESS 2002-04-04-00.00.00.000000 9999-01-01-00.00

SD_USER SITE 2002-04-04-00.00.00.000000 9999-01-01-00.00

SD_USER SD_SITE_CATEGORY 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT SITE 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT SD_SITE_CATEGORY 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST DEPARTMENT 2002-04-04-00.00.00.000000 9999-01-01-00.00

SD_USER DEPARTMENT 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT DEPARTMENT 2002-04-04-00.00.00.000000 9999-01-01-00.00

CompTyp_Cd CHAR 
(17)

AttrTyp_Cd CHAR (17) AttrRul_Strt_DtTm 
TIMESTAMP

AttrRul_End_DtT
TIMESTAMP
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S 000 N

C 000 N

I 000 N

I 000 N

C 000 N

I 000 Y

C 000 Y

I 000 Y

C 000 Y

I 000 Y

C 000 Y

I 000 Y

C 000 Y

I 000 N

C 000 N

I 000 N

I 000 N

I 000 N

I 000 N

C 000 N

C 000 N

C
(1

AttrRul_Dom_ 
Ind CHAR
D_USER DIVISION 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST DIVISION 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT DIVISION 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT OWNER 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST APPROVER_NAME 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT PRIORITY 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST CR_PRIORITY 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT SD_SYSTEM 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST SD_SYSTEM 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT SD_ 
COMPONENT

2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST SD_COMPONNET 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT SD_ITEM 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST SD_ITEM 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT SD_MODULE 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST SD_MODULE 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT SD_PRODUCT_TYPE 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT SD_PROBLEM_TYPE 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT SD_CAUSE_CODE 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT SD_ASSETS_AFFECTD 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST SD_ASSETS_AFFECTD 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST SD_RELATED_INCS 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

ompTyp_Cd CHAR 
7)

AttrTyp_Cd CHAR (17) AttrRul_Strt_DtTm 
TIMESTAMP

AttrRul_End_DtTm 
TIMESTAMP
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.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 Y

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

.00.000000 N

m AttrRul_Dom_ 
Ind CHAR
INCIDENT SD_RELATED_CHNGS 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT DESCRIPTION 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST DESCRIPTION 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT ABSTRACT 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST ABSTRACT 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST SD_RISK_LEVEL 2002-04-04-00.00.00.000000 9999-01-01-00.00

SD_USER PHONE_NUMBER 2002-04-04-00.00.00.000000 9999-01-01-00.00

SD_USER CELL_PHONE_NUMBER 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST CR_PLAN_START 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST CR_ACT_START 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST CR_PLAN_OUTAGE_ST 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST CR_ACT_OUTAGE_ST 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST CR_PLAN_END 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST CR_ACT_END 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST CR_PLAN_OUTAGE_ED 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST CR_ACT_OUTAGE_ED 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST OPEN_TIMESTAMP 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT OPEN_TIMESTAMP 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT CLOSE_TIMESTAMP 2002-04-04-00.00.00.000000 9999-01-01-00.00

INCIDENT FIX_TIME 2002-04-04-00.00.00.000000 9999-01-01-00.00

CHANGE_REQUEST CR_BACKOUT_PLAN 2002-04-04-00.00.00.000000 9999-01-01-00.00

CompTyp_Cd CHAR 
(17)

AttrTyp_Cd CHAR (17) AttrRul_Strt_DtTm 
TIMESTAMP

AttrRul_End_DtT
TIMESTAMP
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C 000 Y

C 000 N

C 000 N

I 000 Y

C 000 N

C 000 Y

C 000 Y

C 000 N

C 000 N

I 000 N

I 000 N

C 000 N

I 000 N

I 000 N

I 000 N

I 000 N

I 000 N

C 000 N

C 000 N

C 000 N

C 000 Y

C
(1

AttrRul_Dom_ 
Ind CHAR
HANGE_REQUEST CR_COMPLETION_CD 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST CR_START_DELAY 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST CR_END_DELAY 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT TYPE 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST APPROVAL_TIMESTAP 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST CR_APP_ACTION 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST CR_APP_STATUS 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST CR_COMPLETE_DATE 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST CR_REQUEST_DATE 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT SD_REPORTD_BY_NM 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT ASSIGNEE_NAME 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

HANGE_REQUEST ASSIGNEE_NAME 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT SD_ASSIGN_GROUP 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT CLOSED_BY 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT IMPACT 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT DUE_DATE 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

NCIDENT FIRST_CALL_RES 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

R_TASK DESCRIPTION 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

R_TASK CR_PLAN_START 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

R_TASK CR_PLAN_END 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

R_TASK CR_TASK_STATUS 2002-04-04-00.00.00.000000 9999-01-01-00.00.00.000

ompTyp_Cd CHAR 
7)

AttrTyp_Cd CHAR (17) AttrRul_Strt_DtTm 
TIMESTAMP

AttrRul_End_DtTm 
TIMESTAMP
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.00.000000 N

.00.000000 N

om_ 

HAR 
)

AttrDom_ 
Ds VARCHAR 
 (254)

Very High

High

Normal

Low

Very Low

No Risk

Low Risk

Some Risk

m AttrRul_Dom_ 
Ind CHAR
Attribute domain (table AttrDom)

CR_TASK CR_TASK_PHASE 2002-04-04-00.00.00.000000 9999-01-01-00.00

CR_TASK CR_TASK_DESC 2002-04-04-00.00.00.000000 9999-01-01-00.00

AttrDom_ 
ID INTEGER

CompTyp_ 
Cd CHAR (17)

AttrTyp_ 
Cd CHAR (17)

AttrDom_Strt_ 
DtTm 
TIMESTAMP

AttrDom_End_ 
DtTm 
TIMESTAMP

AttrD
Val 
VARC
 (254

1 INCIDENT SEVERITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

1

2 INCIDENT SEVERITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

2

3 INCIDENT SEVERITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

3

4 INCIDENT SEVERITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

4

5 INCIDENT SEVERITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

5

6 CHANGE_REQUEST SD_RISK_LEVEL 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

0

7 CHANGE_REQUEST SD_RISK_LEVEL 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

1

8 CHANGE_REQUEST SD_ 
RISK_LEVEL

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

2

CompTyp_Cd CHAR 
(17)

AttrTyp_Cd CHAR (17) AttrRul_Strt_DtTm 
TIMESTAMP

AttrRul_End_DtT
TIMESTAMP
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9 Moderate Risk

1 Some What High 
Risk

1 Very High Risk

1 The incident is in the 
open state

1 The incident has 
been accepted and is 
being worked on

1 The incident has 
been rejected

1 The incident has 
been resolved

1 The incident is in the 
closed state

1 The incident has 
been referred to 
another organization

1 Very High

1 High

A
ID

AttrDom_ 
Ds VARCHAR 
 (254)
CHANGE_REQUEST SD_RISK_LEVEL 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

3

0 CHANGE_REQUEST SD_RISK_LEVEL 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

4

1 CHANGE_REQUEST SD_RISK_LEVEL 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

5

2 INCIDENT SD_STATUS_CODE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Open

3 INCIDENT SD_STATUS_CODE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Accepted

4 INCIDENT SD_STATUS_CODE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Rejected

5 INCIDENT SD_STATUS_CODE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Resolved

6 INCIDENT SD_STATUS_CODE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Closed

7 INCIDENT SD_STATUS_CODE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Referred

8 INCIDENT PRIORITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

1

9 INCIDENT PRIORITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

2

ttrDom_ 
 INTEGER

CompTyp_ 
Cd CHAR (17)

AttrTyp_ 
Cd CHAR (17)

AttrDom_Strt_ 
DtTm 
TIMESTAMP

AttrDom_End_ 
DtTm 
TIMESTAMP

AttrDom_ 
Val 
VARCHAR 
 (254)
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Normal

Low

Very Low

Emergency

Expedited

Normal

The request was 
successful

The request was 
successful with 
problems

The request was 
unsuccessful

The request was 
withdrawn

om_ 

HAR 
)

AttrDom_ 
Ds VARCHAR 
 (254)
20 INCIDENT PRIORITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

3

21 INCIDENT PRIORITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

4

22 INCIDENT PRIORITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

5

23 CHANGE_ 
REQUEST

CR_PRIORITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

1

24 CHANGE_ 
REQUEST

CR_PRIORITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

2

25 CHANGE_ 
REQUEST

CR_PRIORITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

3

31 CHANGE_ 
REQUEST

CR_ 
COMPLETION_ 
CD

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

1

32 CHANGE_ 
REQUEST

CR_ 
COMPLETION_ 
CD

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

2

33 CHANGE_ 
REQUEST

CR_ 
COMPLETION_ 
CD

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

3

34 CHANGE_ 
REQUEST

CR_ 
COMPLETION_ 
CD

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

4

AttrDom_ 
ID INTEGER

CompTyp_ 
Cd CHAR (17)

AttrTyp_ 
Cd CHAR (17)

AttrDom_Strt_ 
DtTm 
TIMESTAMP

AttrDom_End_ 
DtTm 
TIMESTAMP

AttrD
Val 
VARC
 (254
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3 The request was 
cancelled

3

3

4

4

4

4

4

4

4

4

5

A
ID

AttrDom_ 
Ds VARCHAR 
 (254)
5 CHANGE_ 
REQUEST

CR_ 
COMPLETION_ 
CD

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

5

6 SD_USER SD_ 
USER_TYPE

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Requester

7 SD_USER SD_ 
USER_TYPE

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Contact

2 CHANGE_ 
REQUEST

CR_STATUS_ 
CODE

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Open

3 CHANGE_ 
REQUEST

CR_STATUS_ 
CODE

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Closed

4 CHANGE_ 
REQUEST

CR_STATUS_ 
CODE

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Reopened

5 CHANGE_ 
REQUEST

CR_STATUS_ 
CODE

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Waiting

6 CHANGE_ 
REQUEST

CR_APP_ 
ACTION

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Pending

7 CHANGE_ 
REQUEST

CR_APP_ 
ACTION

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Approved

8 CHANGE_ 
REQUEST

CR_APP_ 
ACTION

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Denied

9 CHANGE_ 
REQUEST

CR_APP_ 
STATUS

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Approved

0 CHANGE_ 
REQUEST

CR_APP_ 
STATUS

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Denied

ttrDom_ 
 INTEGER

CompTyp_ 
Cd CHAR (17)

AttrTyp_ 
Cd CHAR (17)

AttrDom_Strt_ 
DtTm 
TIMESTAMP

AttrDom_End_ 
DtTm 
TIMESTAMP

AttrDom_ 
Val 
VARCHAR 
 (254)
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te value is not created. For 
t a hostname or IP Address 
e would not be a row in the 

d

l

ened

ng

om_ 

HAR 
)

AttrDom_ 
Ds VARCHAR 
 (254)

CompAttr_ 
Val VARCHAR 
 (254)

MSrc_Cd* 
CHAR (6)

2 PE2

1 PE2

Teddy PE2
Component attribute (table CompAttr)
If a field is not available for a particular Incident, or Change, then the attribu
example if an incident is opened against a batch job, then usually there is no
associated with that incident record. Therefore, for that incident record ther
table below for IP_HOSTNAME and LAST_IP_ADDRESS.

51 CR_TASK CR_TASK_ 
STATUS

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Close

52 CR_TASK CR_TASK_ 
STATUS

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Initia

53 CR_TASK CR_TASK_ 
STATUS

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Reop

54 CR_TASK CR_TASK_ 
STATUS

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Waiti

AttrDom_ 
ID INTEGER

CompTyp_ 
Cd CHAR (17)

AttrTyp_ 
Cd CHAR (17)

AttrDom_Strt_ 
DtTm 
TIMESTAMP

AttrDom_End_ 
DtTm 
TIMESTAMP

AttrD
Val 
VARC
 (254

CompAttr_ 
ID  
INTEGER

Comp_ 
ID 
INTEGER

AttrTyp_Cd CHAR (17) CompAttr_Strt_DtTm 
TIMESTAMP

CompAttr_End_DtTm 
TIMESTAMP

1 1 PRIORITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

2 2 SEVERITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

3 3 SD_USERID 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000
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4 ed PE2

5 nes PE2

6 NK PE2

7  
k.com

PE2

8 2-3333 PE2

9 5-5555 PE2

1 field PE2

1 e PE2

1 PE2

1 PE2

1 PE2

1 ss 
ation

PE2

1 ty PE2

C
ID
IN

Attr_ 
RCHAR 

MSrc_Cd* 
CHAR (6)
2 SD_STATUS_ 
CODE

2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Accept

2 CONTACT 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Ted Jo

2 COMPANY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

BIGBA

3 E_MAIL_ADDRESS 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

teddy@
bigban

3 PHONE_NUMBER 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

111-22

3 CELL_PHONE_NUMBER 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

444-55

0 2 SITE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

Moore

1 2 SD_SITE_CATEGORY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Remot

2 2 DIVISION 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

46

3 2 DEPARTMENT 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

VISA

4 2 OWNER 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

Alice

5 2 SD_SYSTEM 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Busine
Applic

6 2 SD_COMPONENT 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Securi

ompAttr_ 
  
TEGER

Comp_ 
ID 
INTEGER

AttrTyp_Cd CHAR (17) CompAttr_Strt_DtTm 
TIMESTAMP

CompAttr_End_DtTm 
TIMESTAMP

Comp
Val VA
 (254)
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ServiceC
en

terMortgage 
Application

PE2

Business 
Application

PE2

Client Specific PE2

Fault PE2

Ted cannot 
login to the 
mortgage 
application

PE2

Login to the 
mortgage 
application 
fails

PE2

November 4th 
9:42

PE2

November 4th 
14:35

PE2

CONTACT PE2

Software PE2

Ted PE2

CompAttr_ 
Val VARCHAR 
 (254)

MSrc_Cd* 
CHAR (6)
17 2 SD_ITEM 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

18 2 SD_PRODUCT_TYPE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

19 2 SD_PROBLEM_TYPE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

20 2 SD_CAUSE_CODE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

21 2 DESCRIPTION 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

22 2 ABSTRACT 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

23 2 OPEN_TIMESTAMP 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

24 2 CLOSE_TIMESTAMP 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

25 3 SD_USER_TYPE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

26 2 SD_ASSIGN_GROUP 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

27 3 FIRST_NAME 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

CompAttr_ 
ID  
INTEGER

Comp_ 
ID 
INTEGER

AttrTyp_Cd CHAR (17) CompAttr_Strt_DtTm 
TIMESTAMP

CompAttr_End_DtTm 
TIMESTAMP
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2 PE2

2 -9873 PE2

3 PE2

3 PE2

3 PE2

3 PE2

3 PE2

3 NK PE2

3 rector@ 
k.com

PE2

3 7-8888 PE2

4 6-6966 PE2

4 PE2

4 PE2

C
ID
IN

Attr_ 
RCHAR 

MSrc_Cd* 
CHAR (6)
8 3 LAST_NAME 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Jones

9 3 EMPLOYEE_NUMBER 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

217-45

1 2 ASSIGNEE_NAME 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

Marty

2 2 TYPE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Call

3 4 CR_PRIORITY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

3

4 5 SD_USERID 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

LindaD

5 4 CONTACT 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

Linda

7 4 COMPANY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

BIGBA

8 5 E_MAIL_ADDRESS 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

TheDi
bigban

9 5 PHONE_NUMBER 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

123-98

0 5 CELL_PHONE_NUMBER 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

123-59

1 4 DIVISION 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

ABC

2 4 DEPARTMENT 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

BVDA

ompAttr_ 
  
TEGER

Comp_ 
ID 
INTEGER

AttrTyp_Cd CHAR (17) CompAttr_Strt_DtTm 
TIMESTAMP

CompAttr_End_DtTm 
TIMESTAMP

Comp
Val VA
 (254)
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ServiceC
en

terApplication PE2

Lotus Notes PE2

Client PE2

A1234 PE2

A2345 PE2

A3456 PE2

A4567 PE2

A5678 PE2

A6789 PE2

Upgrade all 
Lotus Notes 
clients from 
4.6 to 5.0 for 
department 
BVDA

PE2

CompAttr_ 
Val VARCHAR 
 (254)

MSrc_Cd* 
CHAR (6)
43 4 SD_SYSTEM 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

44 4 SD_COMPONENT 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

45 4 SD_ITEM 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

46 4 SD_ASSETS_AFFECTD 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

47 4 SD_ASSETS_AFFECTD 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

48 4 SD_ASSETS_AFFECTD 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

49 4 SD_ASSETS_AFFECTD 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

50 4 SD_ASSETS_AFFECTD 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

51 4 SD_ASSETS_AFFECTD 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

52 4 DESCRIPTION 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

CompAttr_ 
ID  
INTEGER

Comp_ 
ID 
INTEGER

AttrTyp_Cd CHAR (17) CompAttr_Strt_DtTm 
TIMESTAMP

CompAttr_End_DtTm 
TIMESTAMP
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5 Notes 
 
ed from 

5.0

PE2

5 PE2

5 ber 
0:00:00

PE2

5 ber 
1:35:00

PE2

5 ber 
0:00:00

PE2

5 ber 
3:40

PE2

5 ber 
1:35

PE2

6 ber 
:42

PE2

6 ber 
3:40

PE2

6 VED PE2

6 VED PE2

6 VED PE2

C
ID
IN

Attr_ 
RCHAR 

MSrc_Cd* 
CHAR (6)
3 4 ABSTRACT 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Lotus 
clients
upgrad
4.6 to 

4 4 SD_RISK_LEVEL 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

2

5 4 CR_PLAN_START 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Decem
17th 0

6 4 CR_ACT_START 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Decem
17th 1

7 4 CR_PLAN_END 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Decem
19th 0

8 4 CR_ACT_END 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Decem
23rd 2

9 4 APPROVAL_TIMESTAP 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Decem
13th 1

0 4 CR_REQUEST_DATE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

Novem
12th 9

1 4 CR_COMPLETE_DATE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Decem
23rd 2

2 4 CR_APP_ACTION 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

APPRO

3 4 CR_APP_ACTION 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

APPRO

4 4 CR_APP_ACTION 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

APPRO

ompAttr_ 
  
TEGER

Comp_ 
ID 
INTEGER

AttrTyp_Cd CHAR (17) CompAttr_Strt_DtTm 
TIMESTAMP

CompAttr_End_DtTm 
TIMESTAMP

Comp
Val VA
 (254)
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ServiceC
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terAlice PE2

Mike PE2

John PE2

1 PE2

November 
12th 9:42

PE2

Switch back to 
Notes 4.6

PE2

Jerry PE2

11 hours, 35 
minutes

PE2

4 days, 23 
hours, 40 
minutes

PE2

REQUESTER PE2

Linda PE2

Jeffrey PE2

CompAttr_ 
Val VARCHAR 
 (254)

MSrc_Cd* 
CHAR (6)
65 4 APPROVER_NAME 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

66 4 APPROVER_NAME 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

67 4 APPROVER_NAME 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

68 4 CR_COMPLETION_CD 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

69 4 OPEN_TIMESTAMP 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

71 4 CR_BACKOUT_PLAN 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

72 4 SD_COORDINATOR_NM 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

73 4 CR_START_DELAY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

74 4 CR_END_DELAY 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

75 5 SD_USER_TYPE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

76 5 FIRST_NAME 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

77 5 LAST_NAME 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

CompAttr_ 
ID  
INTEGER

Comp_ 
ID 
INTEGER

AttrTyp_Cd CHAR (17) CompAttr_Strt_DtTm 
TIMESTAMP

CompAttr_End_DtTm 
TIMESTAMP
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, Version 1.1.

7 4-0000 PE2

8 b PE2

8 ved PE2

8 PE2

8 e client PE2

8 e client 
ne

PE2

8 ber 
0:00:00

PE2

8 ber 
0:00:00

PE2

8 PE2

C
ID
IN

Attr_ 
RCHAR 

MSrc_Cd* 
CHAR (6)
* Note - Reserved. This column is not available in Tivoli Enterprise Data Warehouse

8 5 EMPLOYEE_NUMBER 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

217-97

0 4 ASSIGNEE_NAME 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Jimbo

1 4 CR_APP_STATUS 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Appro

2 4 CR_STATUS_CODE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

Open

3 6 CR_TASK_PHASE 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Updat

4 6 DESCRIPTION 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Updat
machi

5 6 CR_PLAN_START 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Decem
17th 0

6 6 CR_PLAN_END 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.00000

Decem
18th 0

7 6 CR_TASK_STATUS 2002-04-04- 
00.00.00.000000

9999-01-01- 
00.00.00.000000

Initial

ompAttr_ 
  
TEGER

Comp_ 
ID 
INTEGER

AttrTyp_Cd CHAR (17) CompAttr_Strt_DtTm 
TIMESTAMP

CompAttr_End_DtTm 
TIMESTAMP

Comp
Val VA
 (254)



ServiceCenter
Component measurement

Measurement group type (table MGrpTyp)

Measurement group (table MGrp)

Measurement group member (table MGrpMbr)

MGrpTyp_Cd CHAR (6) MGrpTyp_Nm VARCHAR (120)

GROUP Aggregate Types or Group Functions

MGrp_Cd  
CHAR (6)

MGrpTyp_
Cd CHAR 
(6)

MGrp_Parent_ 
Cd CHAR (6)

MGrp_Nm VARCHAR (120)

TOT_E GROUP NULL Total Value Exists

INCID GROUP NULL Incident Measurements

CHANGE GROUP NULL Change Measurements

AVG_E GROUP NULL Average Value Exists

MIN_E GROUP NULL Minimum Value Exists

MAX_E GROUP NULL Maximum Value Exits

MGrp_Cd CHAR (6) MGrpTyp_Cd CHAR (6) MsmtTyp_ID INTEGER

TOT_E GROUP 1-15,21,23,24

MIN_E GROUP 16-20,22

MAX_E GROUP 16-20,22

AVG_E GROUP 16-20,22

CHANGE GROUP 6-22,24

INCID GROUP 1-5,23
98 Chapter 4—Central Data Warehouse Schema Implementation 



Integration for Tivoli Enterprise Data Warehouse
Measurement unit category (table MUnitCat)

Measurement unit (table MUnit)

Time summary (table TmSum)

Measurement source (table MSrc)

MUnitCat_Cd CHAR (6) MUnitCat_Nm VARCHAR (120)

TM Time Duration

QTY Quantity

PRC Percentage

MUnit_Cd CHAR (6) MUnitCat_Cd CHAR (6) Munit_Nm VARCHAR (120)

QTY QTY Quantity

Min TM Minutes

Hr TM Hours

TmSum_Cd CHAR TmSum_Nm VARCHAR (120)

P Point

H Hour

MSrc_Cd CHAR 
(6)

MSrc_Parent_Cd CHAR 
(6)

MSrc_Nm VARCHAR (120)

SD2 NULL Peregrine ServiceCenter 

SDESK1 NULL Service Desk

MODEL1 NULL Tivoli Common Data Model V1
Component measurement  99
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ARCHAR (254)

w

w

w

incidents that have been 

incidents that have been 

w

w

w

change requests that have 

change requests that have 

requests that have been 
ccessfully

change requests that were 
ccessfully with some 

 requests that were 

requests that were cancelled
Measurement type (table MsmtTyp)

MsmtTyp_ID 
INTEGER

MUnit_Cd 
CHAR (6)

MSrc_Cd 
CHAR (6)

MsmtTyp_Nm VARCHAR (120) MsmtTyp_Ds V

1 Min SDESK1 Incident state 1 * See Note Belo

2 Min SDESK1 Incident State 2 * See Note Belo

3 Min SDESK1 Incident State n * See Note Belo

4 QTY SDESK1 Number of Opened Incidents The number of 
opened

5 QTY SDESK1 Number of Closed Incidents The number of 
closed

6 Min SDESK1 Change Request State 1 * See Note Belo

7 Min SDESK1 Change Request State 2 * See Note Belo

8 Min SDESK1 Change Request State n * See Note Belo

9 QTY SDESK1 Number of Opened Change Requests The number of 
been opened

10 QTY SDESK1 Number of Closed Change Requests The number of 
been closed

11 QTY SDESK1 Number of Successful Change Requests The number of 
implemented su

12 QTY SDESK1 Number of Successful Change Requests With 
Problems

The number of 
implemented su
problems

13 QTY SDESK1 Number of Withdrawn Change Requests The number of
withdrawn

14 QTY SDESK1 Number of Cancelled Change Requests The number of 
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e Requests are dy-
 file that is unique 
Resolved, then Re-
ponding measure-
equests vary from 
define the possible 

easurement calcu-

1 s that were 

1 implemented 

1 implemented 
ems

1 withdrawn

1 cancelled 

2 unsuccessful 

2 ncy requests

2 emergency requests

2

2

M
IN

AR (254)
* Note - The measurement type names and descriptions for the Incident and Chang
namic. The strings for the MsmtTyp_Nm and MsmtTyp_IDs are defined in an XML
for each environment. Therefore, if an environment supports an Incident State called 
solved would show up in the MsmtTyp_Nm, if defined in the XML file. The corres
ment description would also be added. Valid states for incidents and Change R
customer to customer. Rather defining a fixed set of states, we allow a customer to 
states.

** Note - Details about how this percentage is calculated is documented Percentage m
lations on page 102.

5 QTY SDESK1 Number of Unsuccessful Change Requests The number of request
unsuccessful

6 PRC SDESK1 Percent of Successful Change Requests ** The percent that were 
successfully

7 PRC SDESK1 Percent of Successful Change Requests With 
Problems ** 

The percent that were 
successfully with probl

8 PRC SDESK1 Percent of Withdrawn Change Requests ** The percent that were 

9 PRC SDESK1 Percent of Cancelled Change Requests ** The percent that were 

0 PRC SDESK1 Percent of Unsuccessful Change Requests ** The percent that were 

1 QTY SDESK1 Number of Emergency Change Requests The number of emerge

2 PRC SDESK1 Percent of Emergency Change Requests ** The percent that were 

3 QTY SDESK1 Time to State * See Note Below

4 QTY SDESK1 Time to State * See Note Below

smtTyp_ID 
TEGER

MUnit_Cd 
CHAR (6)

MSrc_Cd 
CHAR (6)

MsmtTyp_Nm VARCHAR (120) MsmtTyp_Ds VARCH



ServiceCenter
Percentage measurement calculations
Measurements that are percentages are calculated for the 
CHANGE_REQUEST, SERVICE_DESK, and SD_USER component types. 
These measurements are only available after the change request has been 
closed. For the CHANGE_REQUEST and SD_USER components, the 
percentage measurements are either 0 or 100% based. The reason for this is 
that at the CHANGE_REQUEST and SD_USER level the measurement is 
against a single Change request. Either the single change was an emergency 
change, or it was a non-emergency change. Therefore, the percentage at this 
level is always either 0% or 100% when the measurement is viewed at a single 
user or change request level.

For the SERVICE_DESK components, the percentage measurements 
represent the percentages for all closed changes that were made for that 
installation of the service desk. The sample for "Percent Withdrawn", below, 
shows how this measurement is calculated. For this example, 50 changes were 
closed between four and five PM. Of those 50 changes, 3 of the changes were 
withdrawn, 7 cancelled, 35 successful, 0 unsuccessful, and 5 were successful 
with errors.

Percent Withdrawn = (Number Withdrawn in that hour/ total number of 
changes closed for that hour)* 100.

For this example, Percent Withdrawn is 6%. 6 = (3/50)* 100.

Component measurement rule (table MsmtRul)

CompTyp_Cd CHAR (17) MsmtTyp_ID INTEGER

INCIDENT 1-5, 23

CHANGE_REQUEST 6-22, 24

SERVICE_DESK 4, 5, 9-22

SD_USER 4, 5, 9-22, 23, 24
102 Chapter 4—Central Data Warehouse Schema Implementation 
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